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1 • Introduction

1.1 Detector Overview

The Thermo Scientific Dionex™ ICS Series Variable Wavelength Detector 
(Dionex VWD) is a high-quality instrument designed for IC analysis applications 
requiring a UV-Vis detector and for LC analysis applications requiring an inert 
(PEEK™) flow path. The Dionex VWD can be used with the following Thermo 
Scientific Dionex systems: the ICS-5000 (analytical systems only), ICS-2100, 
ICS-1600, ICS-1100, and ICS-900 (as well as some legacy systems). The Dionex 
VWD can be used in numerous laboratory environments for routine analysis, as 
well as for sophisticated research tasks.

Two versions of the Dionex VWD are available: a single-channel version 
(P/N 070220) and a four-channel version (P/N 070221).

• The detector is a dual-beam, variable-wavelength photometer with one 
measurement and one internal reference beam. See Section 2.3 for details 
about the optical system.

Figure 1-1.  Thermo Scientific Dionex ICS Series Variable Wavelength Detector



Dionex VWD Operator’s Manual

2 Doc. 065377-01 1/12

• Two light sources, a deuterium lamp for ultraviolet detection and a tungsten 
lamp for visible and near-infrared wavelength detection, provide a 
wavelength detection range from 190 to 900 nm. For details about the lamps 
and wavelength detection ranges, see Section 2.2.4.

• The four-channel detector measures at up to four wavelengths, by indexing 
between wavelengths several times per second.

• To suppress higher-order radiation, two optical filters are inserted 
(automatically) into the light path (see Section 2.3).

• The wavelength accuracy can be verified via the built-in holmium oxide filter 
(see Section 5.2).

• The detector is controlled with a PC (personal PC) running Microsoft® 
Windows Vista® or Windows® XP and either the Thermo Scientific Dionex 
Chromeleon® 7 Chromatography Data System or Chromeleon® 6.8 
Chromatography Data System. Chromeleon 7 and Chromeleon 6.8 also 
provide data acquisition and data processing functions. 

NOTE Thermo Scientific Dionex Chromeleon® Xpress software
can provide real-time control and monitoring of the
detector, but does not include data management
capabilities.

• Various monitoring, diagnostic, and calibration features are provided for 
system wellness and predictive performance (see Section 2.6.2).
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1.2 Principles of Operation

Photometric detection is based upon the absorption of monochromatic light. The 
degree of absorption depends on the sample molecule, its concentration, the light's 
path length in the sample, and the measurement wavelength.

Absorbance is defined as:

and is related to concentration by the empirical Lambert-Beer's Law: 

where:

UV-Vis spectroscopy allows you to detect the chromophores of analyte molecules 
directly in the sample or to generate them indirectly by derivatization. 
Appendix D provides a list of wavelengths for the absorption maxima of various 
chromophores.

Ir Reference beam intensity

Is Sample beam intensity

Iro Reference beam intensity with autozero

Iso Sample beam intensity with autozero

 Molar absorptivity coefficient of the analyte (L • mol-1 • cm-1) 

c Concentration (mol/L)

l Cell path length (cm)

A
Ir

Is
----
 
 
  Iro

Iso
-------
 
 
 

log–log=

A cl=
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1.3 About This Manual

The electronic version (i.e., PDF file) of the Dionex VWD operator’s manual 
contains numerous hypertext links that can take you to other locations within the 
file. These links include:

• Table of contents entries

• Index entries

• Cross-references (underlined in blue) to sections, figures, tables, etc.

If you are not familiar with how to navigate PDF files, refer to the Help system for 
Adobe® Acrobat® or Adobe Reader® for assistance.

Chapter 1 
Introduction

An overview of the Dionex VWD, including a brief 
description of the detector, the principles of operation, 
and the chromatography software (Chromeleon) required 
for detector operation.

Chapter 2 
Description

Detailed descriptions of Dionex VWD components and 
important operating features.

Chapter 3
Operation

Instructions for routine operation of the Dionex VWD. 
Includes routine preventive maintenance and shutdown 
procedures.

Chapter 4
Troubleshooting

Minor problems that may occur during operation of the 
Dionex VWD, with step-by-step procedures for how to 
isolate and eliminate the cause of each problem. Includes 
a list of Chromeleon Audit Trail error messages, with an 
explanation of the possible cause of each message and 
the corrective action to take.

Chapter 5
Service

Step-by-step instructions for routine service and parts 
replacement procedures the user can perform for the 
Dionex VWD.

Appendix A 
Specifications

Specifications and installation site requirements for the 
Dionex VWD.

Appendix B 
Installation

Step-by-step instructions for unpacking and installing the 
Dionex VWD.
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1.4 Safety and Regulatory Information

The Dionex VWD was manufactured by Thermo Fisher Scientific Corporation at 
the following location: 527 Lakeside Drive, Sunnyvale, CA 94088-3603 U.S.A. 
The Dionex VWD is designed for use with IC (ion chromatography) and HPLC 
(high-performance liquid chromatography) applications and should not be used 
for any other purpose. Operation of a Dionex VWD in a manner not specified by 
Dionex may result in personal injury.

If there is a question regarding appropriate usage, contact Technical Support for 
Dionex products. In the U.S. and Canada, call 1-800-346-6390. Outside the U.S. 
and Canada, call the nearest Thermo Fisher Scientific office.

1.4.1 Safety Messages and Notes

This manual contains warnings and precautionary statements that can 
prevent personal injury and/or damage to the Dionex VWD when 
properly followed. Safety messages appear in bold type and are 
accompanied by icons, as shown below.

Appendix C 
Reordering 
Information

Spare parts for the Dionex VWD.

Appendix D
UV Absorbances

UV cutoff wavelengths of common mobile phases and 
wavelengths for the absorption maxima of various 
chromophores.

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury. Also used to identify a situation or
practice that may seriously damage the instrument, but will not cause
injury.
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Messages d'avertissement en français

Warnhinweise in Deutsch

Notes

Informational messages also appear throughout this manual. These are 
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They alert
you to an unexpected result of an action, suggest how to
optimize instrument performance, etc.

Indicates that the function or process of the instrument may be
impaired. Operation does not constitute a hazard.

Signale une situation de danger immédiat qui, si elle n'est pas évitée,
entraînera des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures mineures à modérées. Également
utilisé pour signaler une situation ou une pratique qui pourrait
gravement endommager l'instrument mais qui n'entraînera pas de
blessures.

Bedeutet unmittelbare Gefahr. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zu kleineren
oder mittelschweren Verletzungen führen. Wird auch verwendet, wenn
eine Situation zu schweren Schäden am Gerät führen kann, jedoch
keine Verletzungsgefahr besteht.
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1.4.2 Safety Symbols

These symbols appear on the Dionex VWD or on labels affixed to the 
Dionex VWD:

1.4.3 Declaration of Conformity

The cTUVus Mark safety label and the CE Mark label on the Dionex 
VWD indicate that it is in compliance with the following standards: EN 
61010-1:2001 (safety), CAN/CSA-C22.2 No. 1010.1-92 + A2:97 
(safety), UL 61010C:2002 R8.02 (safety), and EN 61326:1997, including 
A1:1998 and A2:2001 (EMC susceptibility and immunity).

Alternating current

Primary protective conductor terminal

Secondary protective conductor terminal

Power supply is on

Power supply is off

Indicates a potential hazard. Refer to this operator’s 
manual for an explanation of the hazard and how to 
proceed.
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2 • Description

2.1 Front Features

Figure 2-1 illustrates the features on the front of the Thermo Scientific Dionex 
ICS Series Variable Wavelength Detector (Dionex VWD).

• Use the power button in the lower left corner of the detector for routine on/off 
control of the Dionex VWD. To turn on the Dionex VWD, press the power 
button. To turn off the Dionex VWD, press and hold the power button for 
2 seconds.

NOTE The main power switch is on the Dionex VWD rear
panel (see Section 2.4.1).

Figure 2-1.  Thermo Scientific Dionex ICS Series Variable Wavelength Detector Front 
Features

Front Cover

Status Bar

Power Button
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• The front cover provides access to the interior components of the Dionex 
VWD. To remove the cover, grasp the cover by the sides and pull it straight 
off.

• The status bar provides LEDs (light emitting diodes) that indicate the status of 
several detector functions (see Figure 2-2).

Figure 2-2.  Dionex VWD Status Bar

Button/LED Label If the LED is on ...

CONNECTED The Dionex VWD is connected to a Chromeleon 7 instrument or 
a Chromeleon 6.8 timebase.

ALARM A problem has occurred (for example, a leak). Check the 
Chromeleon Audit Trail for the cause.

DEUTERIUM – UV The deuterium lamp is on.

TUNGSTEN – VIS The tungsten lamp is on.

POWER The Dionex VWD power is on. 

CONNECTED ALARM DEUTERIUM - UV POWERTUNGSTEN - VIS
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2.2 Interior Components

To access the interior components of the Dionex VWD, grasp the front cover by 
the sides and pull it straight off. 

2.2.1 Tubing Slots and Tubing Chase

The tubing slots route tubing (for example, the flow cell inlet tubing) 
from the Dionex VWD interior to outside the detector. 

The tubing chase routes tubing (for example, the waste line from the flow 
cell outlet) from the interior of the Dionex VWD, through the body of the 
module, and to the rear panel (see Figure 2-5).

2.2.2 Leak Sensor and Leak Drain

A leak sensor is installed inside the detector (see Figure 2-3). If the leak 
sensor detects a leak, the ALARM LED on the status bar lights, and an 
error message appears in the Chromeleon Audit Trail. The drip tray 
collects the fluid and the leak drain routes the fluid from the drip tray to 
the drain port on the Dionex VWD rear panel (see Figure 2-5). After 

Figure 2-3.  Dionex VWD Interior View (Front Cover Removed)

2

3

4

5

6

1 Tubing Slots

Tubing Chase2

Leak Sensor

4

5

63 Leak Drain

Flow Cell

Lamp Housing Cover

11

1 1



Dionex VWD Operator’s Manual

12 Doc. 065377-01 1/12

fixing the leak and drying the sensor, clear the ALARM LED (see 
Section 4.2).

2.2.3 Flow Cells

A flow cell is not included with the Dionex VWD and must be 
specifically ordered. Dionex offers two PEEK cells for use with the 
Dionex VWD:

• The standard (analytical) flow cell (P/N 066346), with a volume of 
11 L, is designed for standard bore applications with 3- to 4-mm ID 
separator columns and flow rates of 0.5 to 5.0 mL/min.

• The semi-micro flow cell (P/N 6074.0300), with a volume of 2.5 L, 
is designed for microbore applications with 2-mm ID separator 
columns and flow rates up to 1.0 mL/min.

The flow cells are optimized for fast separations with no loss in 
chromatographic resolution. An identification chip is installed in each cell 
at the factory. The chip stores unique information about the cell, including 
the cell type and the serial number. When the cell is installed, a contact on 
the flow cell's rear panel connects the chip to the detector electronics. The 
detector downloads the information to Chromeleon, where it is used for 
System Wellness and Predictive Performance functions (see 
Section 2.6.2). 

The flow cells are equipped with a built-in heat exchanger. The heat 
exchanger helps adapt the temperature of the solvent to the flow cell 
temperature before the solvent enters the flow cell. The total heat 
exchanger volume is 8.8 L for the standard cell and 5 L for the semi-
micro cell.

The detector is shipped with a dummy cell. Before initial operation of the 
detector, replace the dummy cell with the flow cell. See Section B.4 for 
flow cell installation instructions.

Do not operate either the standard or semi-micro flow cell without
flow for more than 5 minutes while a lamp is on. The heat from the
lamp may damage the PEEK cell. 

Do not use the standard or semi-micro flow cell with normal phase or
chlorinated solvents; these solvents will damage the PEEK cell.
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2.2.4 Lamps

The detector is shipped with a deuterium lamp (P/N 066347) for UV 
wavelength detection and a tungsten lamp (P/N 066348) for visible and 
near-infrared wavelength detection. The wavelength detection range is 
from 190 to 900 nm. The table below lists the lamp(s) to use for various 
wavelength detection ranges. 

The lamps are installed behind the lamp housing cover (see Figure 2-3).

An identification chip is installed in each lamp at the factory. The chip 
stores unique identification and status information about the lamp, 
including the lamp type, serial number, number of lamp starts, lamp age, 
and lamp intensity. When the lamp is installed, a contact on the lamp 
connects the chip to the detector electronics. The detector downloads the 
information to Chromeleon, where it is used for System Wellness and 
Predictive Performance functions (see Section 2.6.2).

2.3 Optical System

Figure 2-4 is a schematic of the optical system. A concave mirror (2) focuses the 
light from the tungsten lamp (1) to the aperture of the deuterium lamp (3). 
Another mirror (4) receives the combined light from both light sources and 
focuses it into the entrance slit (6). A filter paddle (5) automatically places a cutoff 
filter in the light path for use in analyses: A 360 nm filter is placed in line for 
analytical wavelengths between 360 and 580 nm; a 580 nm filter is placed in line 
for analyses at wavelengths above 580 nm.

The light passes through the entrance slit to the mirror (7) and on to the optical 
grating (8), where the light beam is diffracted into the component wavelengths. 
The angular position of the grating determines which wavelength is directed to the 
reference mirror (10) and flow cell (12). The reference mirror (10) directs part of 
the light beam to the reference detector (11). The remaining light travels through 

Wavelengths Detected Lamp

<345.0 nm UV

>670.0 nm Vis

Between 345.0 and 670.0 nm UV or Vis (or both)

<345.0 nm and >670.0 nm UV and Vis
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the flow cell (12) to the detector (13), where the absorbance of the analyte is 
measured and processed.

Figure 2-4.  Dionex VWD Optical System

No. Component Description

1 Tungsten lamp Light source for the visible and near-infrared wavelengths 
(345 to 900 nm).

2 Mirror (Vis) Focuses the light from the tungsten lamp to the through hole 
(aperture) of the deuterium lamp.

3 Deuterium lamp Light source for the UV wavelengths (190 to 670 nm).

4 Mirror Focuses the combined light of both lamps to the entrance 
slit.

5 Filter paddle Fitted with optical filters to suppress higher-order radiation 
and a holmium oxide filter for verification of wavelength 
accuracy.
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6 Entrance slit Limits the bandwidth of the light that is directed to the flow 
cell.

7 Mirror Directs the light to the optical grating.

8 Optical grating Grating (1800 l/mm) selects the wavelength of light 
impinging on the sample.

9 Mirror Directs the diffracted, monochromatic light from the grating 
to the flow cell. 

10 Reference mirror Directs part of the light beam to the reference detector. The 
reference mirror is installed in front of the flow cell. 

11 Reference detector Provides a reference signal that compensates for fluctuations 
in the intensity of the light source.

12 Flow cell Provides the measurement site for sample absorbance. The 
mobile phase with the analyte travels through the flow cell. 
The measurement beam travels through the flow cell to the 
detector. 

13 Detector Measures the light intensity of the measurement beam after 
absorbance though the sample.

No. Component Description
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2.4 Rear Panel

Figure 2-5 illustrates the rear panel of the Dionex VWD.

2.4.1 Main Power Switch, Fuse Cartridge, and Power 
Receptacle

The power switch on the rear panel is the main power switch for the 
Dionex VWD. Turn on the main power switch before initial operation and 
leave it on unless instructed to turn it off (for example, before performing 
a service procedure).

NOTE For routine on/off control, use the power button
on the front of the Dionex VWD (see
Figure 2-2). To turn off the detector, press and
hold the power button for 2 seconds.

Figure 2-5.  Dionex VWD Rear Panel 
(Analog Output Connectors not Installed)

1
3 4

5

2

1 Main Power Switch, Fuse 
Cartridge, Power Receptacle

Digital I/O Ports2

USB Receptacle

4

5

63 Drain Port

Analog Outputs (optional)

Tubing Chase

6
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The fuse cartridge contains two IEC 60127-2 time lag fuses (P/N 954776) 
rated at 2 A, 250 VAC. For instructions on how to change the fuses, see 
Section 5.7.

The power cord plugs into the IEC 320 three-prong receptacle. 

2.4.2 Digital I/O Ports

Two digital I/O ports (A and B) provide four TTL inputs and four relay 
outputs for communication with external devices.

To connect an external device to a digital I/O port, use the 6-pin mini-DIN 
cable (P/N 6074.0001) provided in the Dionex VWD Ship Kit 
(P/N 064787). See Section B.6 for connection instructions and for the 
functions assigned to the connector pins and cable.

2.4.3 USB Connector

One USB receptacle (“B” type connector) allows a connection between 
the PC on which Chromeleon is installed and the detector. 

A 0.9-m (3-ft) USB cable (P/N 063246) is provided in the Dionex VWD 
Ship Kit (P/N 064787).

2.4.4 Analog Outputs (Optional)

If the optional DAC plug-in module (P/N 066349) is installed, two analog 
outputs with a resolution of 20 bits each are provided. The analog outputs 
supply a voltage signal proportional to the current measured by the flow 
cell. The outputs can be connected to an analog-to-digital (A/D) converter 

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the Dionex VWD and is easily
accessible. 

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.
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such as an integrator or other recording device. Refer to Section B.7 and 
the documentation for the device for connection instructions.

You can select the output mode, offset, and range in the Chromeleon 7 
Command window or the Chromeleon 6.8 Commands dialog box. 
Table 2-1 describes the available settings.

2.4.5 Tubing Chase

The tubing chase routes tubing (for example, the waste line from the flow 
cell outlet) from the interior of the Dionex VWD, through the body of the 
module, and to the rear panel.

Analog Output 
Setting

Values Description

Analog1_Mode
Analog2_Mode

Ref_A, Ref_B, 
Ref_C, Ref_D
Measm_A, Measm_B, 
Measm_C, Measm_D
Abs_A, Abs_B, 
Abs_C, Abs_D
Direct

Sets the signal type available at the 
analog output. For a single 
wavelength detector, only the Ref_A, 
Measm_A, Abs_A, and Direct 
signals are available.

Analog1_Offset
Analog2_Offset

5% to 50% Adjusts the zero position of the 
analog output when it is plotted. The 
value entered is a percentage of the 
full-scale analog output. An offset 
allows a recording device to plot the 
signal if it becomes negative. The 
offset level does not affect the 
magnitude of the output signal.

Range 1AU_per_1V
0.01AU_per_1V
5AU_per_1V
1AU_per_10V
0.01AU_per_10V
5AU_per_10V

Sets the resolution of the analog 
output signal. The range to use 
depends on the detector readings 
expected for the application and the 
recording device to which the analog 
output is connected.

Table 2-1. Analog Output Configuration Settings
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2.4.6 Drain Port and Drain Tube

Liquid (for example, from a leak) is routed from the drip tray inside the 
detector to the drain port on the rear panel. Connect the drain tube 
(P/N 055075), provided in the Dionex VWD Ship Kit (P/N 064787), to 
the port. See Section B.5 for installation instructions.

Place the free end of the drain tube into a waste container. To ensure 
proper drainage, position the waste container below the level of the 
detector.

2.5 Operating Guidelines

2.5.1 Wavelength Selection

There are two key criteria for determining the wavelength for an analysis:

• Sample components should absorb strongly at the selected 
wavelength. For best results, select a wavelength on the absorption 
maximum. For a list of wavelengths for the absorption maxima of 
various chromophores, see Appendix D.

• The mobile phase should be “transparent,” showing little or no 
absorption at the selected wavelength.

2.5.2 Mobile Phases

Mobile phase quality significantly affects detection limits and instrument 
performance. To ensure optimal performance of the detector, observe the 
following guidelines:

• Prepare all mobile phases and reagents with spectro-grade solvents, 
reagent-grade chemicals, and ASTM Type I (18 megohm-cm) 
filtered, deionized water that meets the specifications listed in 
Table B-1.

• Degas all mobile phases before use and maintain them in a degassed 
state.

The drain tube must remain below the drain port. If any part of the
drain tube is above the drain port, the drip tray may overflow inside
the detector.
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• Strong bases can etch the silica windows of the flow cell. If the 
mobile phase is a base, make sure the mobile phase concentration 
does not exceed 0.1 M. If the concentration of the base is greater than 
50 mM, disconnect the separator column and flush the system with 
ASTM Type I (18 megohm-cm) filtered, deionized water for 
5 minutes at 1.0 mL/min immediately after the analysis.

• Mobile phase pH affects not only the retention time of the separation, 
but the sample absorbance and the background absorbance of the 
mobile phase. 

• When changing from a buffer to a different operating mobile phase, 
be sure the solvents are miscible and will not induce precipitation of 
the buffers. Flush the cell with a buffer-compatible solvent (in most 
cases, ASTM Type I (18 megohm-cm) filtered, deionized water) 
immediately after the analysis. Do not allow buffers to remain in the 
cell for extended periods.

2.5.3 Mobile Phase Delivery System

The pumping system should deliver continuous flow while ensuring good 
mixing of the solvent (if gradient elution is used). Fluctuations in pump 
backpressure can cause baseline noise. If the signal noise is found to be 
regular and cyclical, monitor the pump for pressure fluctuations. Refer to 
the pump manual for troubleshooting information.

The plastics present in some solvent delivery systems are not fully 
compatible with the solvents commonly used in chromatography. 
Therefore, plastic components may dissolve and thus impair UV 
detection.

For UV operation, these guidelines are recommended:

• The solvent reservoir should be glass.

• All tubing connections should be made of materials suitable for IC or 
HPLC applications (e.g., PEEK, stain les steel, Tefzel®, or titanium), 
as required for the operating pressure and application.

• Some pump seals incorporate a band spring to preload the seal during 
the vacuum stroke of the piston. The band spring should be stainless 
steel, a fluoropolymer (Kalrez®or fluorosilicone), or other material of 
known quality.
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2.6 Chromatography Software

2.6.1 Overview

The Dionex VWD is controlled by a PC configured with either the 
Chromeleon 7 Chromatography Data System or the Chromeleon 6.8 
Chromatography Data System. Both software products provide extensive 
instrument control, data management, reporting, and compliance features.

In Chromeleon 7, an ePanel Set provides centralized system control. You 
can use the ePanel Set to view system status information and to issue 
commands for controlling each module. In Chromeleon 6.8, these 
functions are available on a panel tabset. 

In both the ePanel Set and the panel tabset, a convenient Home panel 
shows the overall system status and provides basic module control 
functions. The VWD tab provides access to Dionex VWD functions, as 
well as detailed status and diagnostics information. Figure 2-6 shows the 
Dionex VWD ePanel in Chromeleon 7.

Figure 2-6.  Example Dionex VWD ePanel in Chromeleon 7
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 Figure 2-7 shows the Dionex VWD Control panel in Chromeleon 6.8.

Two modes of software control are available: direct control and 
automated control.

• With direct control, you select operating parameters and commands 
from the Chromeleon 7 Command window and ePanel or the 
Chromeleon 6.8 Commands dialog box and Control panel. Direct 
control commands are executed as soon as they are entered. See 
Section 3.3 for details about direct control.

NOTE To open the Chromeleon 7 Command window,
press F8 or click Command on the Instrument
toolbar above the ePanel Set. To open the
Chromeleon 6.8 Commands dialog box, press
F8 or click Control > Command. 

• With automated control, you create a predefined list of commands 
and parameters (called an instrument method in Chromeleon 7 or a 

Figure 2-7.  Example Dionex VWD Control Panel in Chromeleon 6.8
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program in Chromeleon 6.8). The commands are executed at specific 
times, allowed automated operation of the detector. Instrument 
methods and programs can be created automatically (with the help of 
a software wizard) or manually (by editing an existing instrument 
method or program). See Section 3.4 for details about automated 
control.

2.6.2 System Wellness and Predictive Performance

System Wellness monitors the overall “health” of a chromatographic 
system. It provides built-in diagnostic and calibration features that help 
prevent unscheduled system shutdowns and assure reliable operation of 
system devices. Predictive Performance provides various functions for 
estimating the lifetime of replaceable parts and for planning and recording 
service and qualification procedures.

A partial list of System Wellness and Predictive Performance features is 
provided below. For a complete list of available features, refer to the 
Chromeleon Help.

• Recording of detector properties, including the serial number, 
firmware version, and operating hours 

• Recording of flow cell properties, including the serial number

• Recording of lamp properties, including the serial number and lamp 
type

• Monitoring of lamp properties, including lamp ignitions, lamp 
operation time, and lamp intensity 

• Setting of limits for the lamp intensity and lamp operation time, 
including display of warning messages when limits are exceeded

• Reminders for service and qualification periods, including display of 
warning messages when limits are exceeded

• Leak detection

• Wavelength verification

System Wellness and Predictive Performance commands and parameters 
are available in the Chromeleon 7 Command window or the Chromeleon 
6.8 Commands dialog box.
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3 • Operation and Maintenance

3.1 Startup

3.1.1 Initial Startup

To start the Thermo Scientific Dionex ICS Series Variable Wavelength 
Detector (Dionex VWD) for the first time, turn on the main power switch 
on the rear panel of the detector (see Figure 2-5).

The following sequence of events occurs when the main power switch is 
turned on:

• The detector begins running a series of internal tests. During these 
self-diagnostics, all of the main components are checked and the 
LEDs on the front status bar light sequentially. During this time 
(about 30 seconds), the detector cannot be connected to Chromeleon. 
When testing is complete, three beeps sound. 

• If an error is detected, the detector is not yet ready for analysis and the 
ALARM LED on the status bar lights. If the error is related to a lamp, 
the corresponding lamp LED flashes. After the detector is connected 
to Chromeleon, an error message is logged in the Audit Trail. If this 
occurs, see Section 4.1 for troubleshooting information.

After initial startup, leave the main power switch on unless instructed to 
turn it off (for example, before performing a service procedure).

For routine on/off control, use the power button on the front of the Dionex 
VWD (see Figure 2-1). To turn off the detector, press and hold the power 
button for 2 seconds.
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3.1.2 Connect to the Chromeleon 7 Client

1. Start the Instrument Controller Service, if it is not already running. If 

the Chromeleon tray icon on the taskbar is crossed out in red , 
the Instrument Controller Service is not running. To start it, right-
click the icon and select Start Chromeleon Instrument Controller. 

The icon changes to gold  to indicate that the Instrument 

Controller Service is starting. When the Instrument Controller 

Service is running (idle), the icon changes to gray . 

If the Chromeleon tray icon is not on the taskbar, click Start > All 
Programs > Chromeleon 7 > Services Manager to open the 
Services Manager and click Start Instrument Controller. 

2. Start the Chromeleon 7 client:

a. Click Start on the Windows taskbar and select All Programs > 
Chromeleon 7 > Chromeleon 7. 

b. Click the Instruments Category Bar on the Console. 

c. On the Navigation Pane, click the instrument that includes the 
detector. The ePanel Set for the instrument appears in the Console 
Work Area.

d. To display the detector ePanel, click the VWD tab on the ePanel 
Set (see Figure 3-2).

e. Verify that the Connected check box is selected. If it is not, click 
the box to connect the Dionex VWD to Chromeleon 7.

NOTE After starting Chromeleon 7 and connecting to
the ePanel, the Connected LED on the
detector’s status bar is blue.
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3.1.3 Connect to the Chromeleon 6.8 Client

1. Start the Chromeleon Server, if it is not already running. If the 

Chromeleon Server icon on the taskbar is crossed out in red , the 
Server is not running. To start the Server, right-click the icon and 
select Start Server. When the server is running (and data acquisition 

is not occurring), the icon is gray .

If the Server Monitor icon is not on the taskbar, click Start on the 
taskbar and select All Programs > Chromeleon > Server Monitor. 
Click Start to start the server. 

2. Start the Chromeleon 6.8 client:

a. Click Start on the Windows taskbar and select All Programs > > 
Chromeleon > Chromeleon. 

Figure 3-1.  Example Dionex VWD ePanel in Chromeleon 7
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b. Select View > Default Panel Tabset or click the corresponding 

toolbar button  to display the panel tabset.

c. To display the Dionex VWD Control panel, select the VWD tab 
on the panel tabset (see Figure 3-2). 

d. Verify that the Connected check box is selected. If it is not, click 
the box to connect the Dionex VWD to Chromeleon 6.8.

NOTE After starting Chromeleon 6.8 and connecting
to the Control panel, the Connected LED on the
detector’s status bar is blue.

Figure 3-2.  Example Dionex VWD Control Panel in Chromeleon 6.8
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3.1.4 Turn On the Lamps

To turn on the lamps, click UV Lamp and VIS Lamp on the Chromeleon 
7 ePanel or the Chromeleon 6.8 Control panel. 

When a detector lamp is turned on for the first time after the detector 
power is turned on, wavelength calibration is performed automatically. 
Calibration starts shortly after the lamp is ignited. The 0-order radiation is 
checked. The 0-order position is where all light is reflected off the grating 
and no diffraction occurs; this position is thus used as the “home” position 
for the grating.

NOTE If you want the lamps to be turned on automatically
at startup, execute the AutoactivateUV_Lamp=On
and AutoactivateVisible_Lamp=On commands in
the Chromeleon 7 Command window or the
Chromeleon 6.8 Commands dialog box. 

3.2 System Equilibration

Before you can begin using the detector for sample analysis, the chromatography 
system must be equilibrated. To equilibrate the system, perform the following 
tasks:

• Pump the starting solvent through the entire system until the system is free of 
any other liquid composition.

• Heat or cool all temperature-controlled devices (for example, a column 
compartment) to the temperature required for the application.

• Set the detector wavelength(s) and turn on the lamp(s). (Wavelength 
calibration occurs automatically at this point.)

NOTE To achieve optimum results, allow 60 minutes for the
lamp(s) to stabilize before beginning operation.

• Monitor the pump pressure and verify that the reading is correct for the 
application and is stable. 

• Monitor the detector signal and verify that the baseline signal is at the 
expected reading for your application and is stable. This may not be the case if 
the solvent composition has been modified, or if air bubbles exist in the light 
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path. If necessary, see Section 4.5 and Section 4.6 for troubleshooting 
information.

Select one of the following methods to perform the equilibration tasks: 

• Select operating commands and parameters directly from the Chromeleon 7 
ePanel Set or the Chromeleon 6.8 Control panel. See Section 3.3 for details 
about direct control.

• Create and run an equilibration instrument method or program to automate the 
process. See Section 3.4 for details about automated control. 

• If you are running Chromeleon, you can use the Smart Startup feature to 
automate system startup and equilibration. In Chromeleon 7, you first create 
an instrument method from which the Smart Startup settings are derived. In 
Chromeleon 6.8, you can use the Smart Startup Wizard to create a Smart 
Startup program. Refer to the Chromeleon Help for details.

3.3 Direct Control

With direct control, you select operating commands and parameters from the 
following locations:

• Chromeleon 7 ePanel Sets or the Command window

–or–

• Chromeleon 6.8 Control panels or the Commands dialog box

Direct control commands are executed as soon as they are entered. Most routine 
direct control functions can be performed from ePanels or Control panels. 

For other functions, you can use the Command window or Commands dialog box. 
These provide access to all the available commands and properties for the Dionex 
VWD, as well as commands for other devices in the instrument or timebase, 
respectively.

To issue direct control commands to the Dionex VWD:

1. Open the ePanel Set (see Section 3.1.2) or panel tabset (see Section 3.1.3) and 
click the tab for the detector.

2. Use the controls (buttons, sliders, etc.) on the panel to issue commands. 

3. If the function you want to perform is not available from the panel, open the 
Command window or Commands dialog box (see the instructions below).



3 • Operation and Maintenance

Doc. 065377-01 1/12 31

The commands available in the Command window or Commands dialog box 
vary, depending on these variables:

• The version of Chromeleon installed

• The display filter level (Normal, Advanced, or Expert)

• The options selected for the detector in the Properties dialog box in 
the Chromeleon 7 Instrument Configuration program or the 
Chromeleon 6.8 Server Configuration program (see Section B.11.3)

To open the Chromeleon 7 Command window:

1. Open the ePanel Set for the instrument that includes the Dionex VWD.

2. Click Command on the Instrument toolbar above the ePanel Set (or press 
the F8 key).

The Command window appears (see Figure 3-3).

Figure 3-3.  Command Window
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3. Click UV and then click the Properties tab or Commands tab to view 
detector properties or commands, respectively. To execute a command, click 
the button next to the command.

NOTE To change the display filter level, right-click the list of
commands and select the preferred filter on the context
menu.

To open the Chromeleon 6.8 Commands dialog box:

1. Open the Dionex VWD Control panel. 

2. Select Control > Commands (or press the F8 key).

The Commands dialog box appears (see Figure 3-4).

3. To see the commands available for the Dionex VWD, click the plus sign next 
to UV. To execute a command, click the Execute button.

NOTE To change the display filter level, right-click the list of
commands and select the preferred filter on the context
menu.

Figure 3-4.  Commands Dialog Box
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3.4 Automated Control 

You can control the Dionex VWD automatically by running instrument methods 
(in Chromeleon 7) or programs (in Chromeleon 6.8) that specify the function the 
detector and other system instruments should perform at a specific time. 
Instrument methods and programs can be created automatically (with the help of a 
software wizard) or manually (by editing an existing instrument method or 
program). 

To prepare for automated control, create a sequence (a list of injections) and 
specify the instrument method or program to run on each injection. The sequence 
also includes a processing method (in Chromeleon 7) or quantification method (in 
Chromeleon 6.8) for peak identification and area determination. 

The following table lists the main steps required to set up and run the Dionex 
VWD automatically. Refer to the Chromeleon Help for details about these steps.

3.5 Optimizing Detector Performance

The performance of the Dionex VWD can be optimized by careful selection of 
key operating parameters. This section defines these parameters, describes how 
they interact, and offers guidelines for selecting them. The following table 
summarizes the topics discussed here:

In Chromeleon 7 In Chromeleon 6.8

Create a sequence and specify the 
instrument method files to use for each 
injection

Create a sequence and specify the 
program files to use for each injection

Load the sequence into the queue Load the sequence into the batch

Start the queue Start the batch

Operating Parameter Performance Characteristics Affected

Time constant Peak resolution, sensitivity, baseline noise

Data collection rate Peak resolution, disk space

Wavelength Sensitivity, linearity

Step*

* Set automatically by Chromeleon 6.8; not available in Chromeleon 7.

Baseline noise, time constant, data collection rate, disk space

Average* Time constant, data collection rate
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3.5.1 Time Constant

The time constant is a measure of how quickly the detector responds to a 
change in signal. The time constant can be set to any value between 0.00 
and 4.55 seconds. The selected time constant applies to all UV-Vis data 
collected.

Select a time constant that is about 10% of the peak width at half-height 
for the narrowest peak of interest. A longer time constant allows more 
averaging of the signal and results in less short-term noise. However, a 
time constant that is too long may result in reduced peak heights and 
asymmetric peak shapes. When set correctly, the time constant 
significantly reduces baseline noise, but reduces peak height only slightly.

The Chromeleon 7 Instrument Method Wizard or Chromeleon 6.8 
Program Wizard will automatically calculate the time constant (and data 
collection rate), based on the value you enter for peak width at half-height 
on the Channels page (in Chromeleon 7) or the UV Options page (in 
Chromeleon 6.8). 

3.5.2 Data Collection Rate

The data collection rate is the number of data points per second (Hz) that 
Chromeleon collects from the detector and stores as raw data. The 
number of data points per second generated by the detector electronics 
depends on the detector version. The single-channel Dionex VWD 
generates data at 10.0 Hz; the four-channel Dionex VWD generates data 
at 100.0 Hz.

The Dionex VWD data collection rate can be set to between 0.2 and 
10.0 Hz (for a single-channel Dionex VWD) or 0.2 and 100.0 Hz (for a 
four-channel Dionex VWD). 

• In general, each peak should be defined by at least 20 data points. For 
chromatograms with co-eluting peaks or low signal-to-noise ratios, 
40 data points per peak is recommended.

• If all peaks are relatively wide, select a slower data collection rate 
(1.0 Hz, for example).

• If any peaks of interest are less than a few seconds wide, select a 
faster data collection rate (10.0 Hz, for example).
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• If the data collection rate is too slow, the start and end points of peaks 
are not accurately determined. If the collection rate is too fast, data 
files may occupy excessive disk space and post-run analyses may 
require more processing time.

• In multiple wavelength applications, baseline noise increases at 
higher data collection rates, especially if the data collection rate is at 
or near the recommended maximum rate. To reduce noise, select a 
lower data collection rate. For example, try selecting a rate that is 
75% of the maximum recommended.

• The data collection rate and time constant settings are typically paired 
to optimize the amount of data collected and reduce short-term noise, 
while still maintaining peak height, symmetry, and resolution. 

The Chromeleon 7 Instrument Method Wizard or Chromeleon 6.8 
Program Wizard will automatically calculate the data collection rate 
and corresponding time constant, based on the value you enter for 
peak width at half-height (see Section 3.5.1).

• The following table lists recommended settings for the data collection 
rate and time constant for various peak widths.

Width at Half-Height 
for the Narrowest 
Peak of Interest (Min-
utes)

Data Collection 
Rate (Hz)

Time Constant 
(Seconds)

0.75 0.5 4.50

0.50 0.5 3.00

0.25 1.0 1.50

0.10 2.5 0.60

0.05 5.0 0.30

0.01 25.0 0.06

0.005 50.0 0.03
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3.5.3 Step (Chromeleon 6.8 only)

A step is the time interval between two successively stored data points. 
The shorter the step, the more data points recorded and, in general, the 
more precise the analytical results. At the start of data acquisition, 
Chromeleon 6.8 automatically selects the step value that is the inverse of 
the data collection rate selected by the user. For example, if the data 
collection rate is 5.0 Hz, Chromeleon 6.8 sets the step to 0.2 second at the 
start of data acquisition. 

Step Override

 

In almost all cases, the step setting selected by Chromeleon 6.8 is the 
preferred setting. However, it is possible to override this setting by 
manually changing the step in the program (on the Control panel). In 
contrast to the data collection rate, which applies to all enabled signals, 
the step setting is set separately for each signal. Ideally, the step is no 
smaller than the interval suggested for the data collection rate (see the 
table in Section 3.5.2). The advantage of a larger step size is that it 
reduces the amount of data stored.

If you select a larger step size when the Average parameter is on (see 
Section 3.5.4), the system response is a combination of the selected data 
collection rate and the average of the data points between steps. If you 
select a larger step size when the Average parameter is off, the selected 
data collection rate is valid, but some data points will be skipped. 

At the start of data acquisition, Chromeleon 6.8 automatically selects
a step setting that is the inverse of the data collection rate. Therefore,
it is not necessary for users to select a step setting.

This section explains how to override the step setting automatically
selected by Chromeleon 6.8. This information is provided for
reference for advanced users only. Be aware that selecting an
inappropriate step setting may cause loss of sensitivity, skipped data
points, and other problems. 
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3.5.4 Average (Chromeleon 6.8 only)

The Average parameter operates in conjunction with the Step parameter 
(see Section 3.5.3). 

When Average is On, Chromeleon 6.8 averages the data points between 
Step intervals and reports that value. Noise is reduced. This setting is 
recommended for most applications. 

When Average is Off, Chromeleon 6.8 reports the data points at the step 
interval. The data points between steps are skipped and noise is not 
reduced.

3.5.5 Sample Wavelength Selection

The Dionex VWD can measure absorbance in the wavelength range from 
190 to 900 nm. Set the sample wavelength to the wavelength with the 
absorbance maxima for the analytes of interest. See Appendix D for a list 
of the UV absorbance wavelengths of common chromophores.

3.6 Shutdown

3.6.1 Short-term Shutdown

If the detector will be shut down for one week or less, make sure that any 
caustic eluent, with pH higher than 8, is removed from the flow cell by 
flushing with water. No other special shutdown procedure is required.

The Smart Shutdown feature in Chromeleon 7 or Chromeleon 6.8 can 
assist you in creating and running a shutdown or standby procedure. For 
shutdown, the detector lamps must be turned off (because the pump flow 
is off). For standby, you can choose whether to turn off the lamps or leave 
them on (because the pump flow remains on during standby). For details 
about Smart Shutdown, refer to the Chromeleon Help.
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3.6.2 Long-term Shutdown

Observe the following precautions before shutting down the detector for 
more than one week or before shipping the detector:

• Flush out any solvents from the flow cell, using water followed by 
isopropanol (IPA). 

• Always make sure a flow cell (or dummy flow cell) is installed, even 
during periods of inactivity. This prevents dust particles from 
damaging the detector optics.

3.7 Routine Maintenance

This section describes routine maintenance procedures for the Dionex VWD that 
users can perform. All other maintenance procedures must be performed by 
Thermo Scientific personnel.

3.7.1 Daily Maintenance

• Inspect the fluid connections for leaks or restrictions. Replace tubing 
and fittings as needed (see Section 5.1).

• When using buffer solutions, flush the system thoroughly after use 
with a solvent that does not contain buffers and/or salts.

• Check the volume of liquid in the waste container and empty as 
needed.

Before moving or shipping the detector, tighten the two shipping
locks on the detector bottom (see Section B.3) to secure the optics.

Neutralize acidic and caustic wastes before disposal. Dispose of all
wastes in accordance with local regulations.

Neutralisez les déchets acides ou caustiques avant de les jeter. Jetez
les déchets aux règlements locaux.

Neutralisieren Sie säurehaltige und ätzende Abfälle vor ihrer
Entsorgung. Entsorgen Sie alle Abfälle entsprechend den lokalen
Bestimmungen.
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3.7.2 Periodic Maintenance

• Check the drain tube connected to the leak tray (see Figure 2-5). 
Verify that the tubing is unclogged and is routed below the drain port.

• Monitor the lamp intensity and the number of hours the lamp has 
been in operation. You can view this information in the Chromeleon 7 
Command window or the Chromeleon 6.8 Commands dialog box.

• Replace the lamp if the intensity falls below the low limit. See 
Section 5.3 to replace a deuterium lamp or Section 5.4 to replace a 
tungsten lamp.
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4 • Troubleshooting

This chapter is a guide to troubleshooting minor issues that may arise during 
operation of the Thermo Scientific Dionex ICS Series Variable Wavelength 
Detector (Dionex VWD). 

• Section 4.1 describes error messages and how to troubleshoot them.

• Section 4.3 through Section 4.8 describe operating problems and how to 
resolve them. 

If you are unable to resolve a problem by following the instructions here, contact 
Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-
6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific 
office.

4.1 Audit Trail Error Messages

The Moduleware (the instrument control firmware installed in each Dionex 
VWD) periodically checks the status of certain parameters. If a problem is 
detected, it is reported to Chromeleon 7 or Chromeleon 6.8 and logged in the 
Audit Trail. Each error message is preceded by an icon that identifies the 
seriousness of the underlying problem (see the table below).

Icon Severity Level Description

Warning A message is displayed in the Audit Trail, but the 
current run is not interrupted.

 Error A message is displayed in the Audit Trail, and the 
system attempts to correct the problem (sometimes 
by using an alternative parameter). An Error never 
interrupts the current analysis; however, if it occurs 
during the Ready Check, the analysis will not be 
started.

Abort A message is displayed in the Audit Trail, and the 
running batch is aborted.



Dionex VWD Operator’s Manual

42 Doc. 065377-01 1/12

The following table lists the most frequently observed Dionex VWD-related error 
messages and their default severity levels. For troubleshooting assistance, refer to 
the page indicated in the table.

Dionex VWD-Related Audit Trail Error Message Default 
Severity Level

See

The counter UVRelIntensity (value: x%) has fallen 
below its limit (x%). Module should no longer be used. 
Replace the UV lamp.

Error page 44

The counter VISRelIntensity (value: x%) has fallen 
below its limit (x%). Module should no longer be used. 
Replace the VIS lamp.

Error page 44

The counter UVLampOperationTime (value: x hours) 
has exceeded its limit (x hours). Module should no 
longer be used. Replace the UV lamp.

Error page 45

The counter VISLampOperationTime (value: x hours) 
has exceeded its limit (x hours). Module should no 
longer be used. Replace the VIS lamp.

Error page 45

Critical module failure. Abort page 45

DAC 1 configured, but not present. Please check 
configuration using the Instrument Configuration 
program.

Warning page 45

DAC 1 configured, but not present. Please check 
configuration using the Server Configuration program.

Warning page 45

DAC 1 not configured, but present. Please check 
configuration using the Instrument Configuration 
program.

Warning page 46

DAC 1 not configured, but present. Please check 
configuration using the Server Configuration program.

Warning page 46

DAC 2 configured, but not present. Please check 
configuration using the Instrument Configuration 
program.

Warning page 45

DAC 2 configured, but not present. Please check 
configuration using the Server Configuration program.

Warning page 46

DAC 2 not configured, but present. Please check 
configuration using the Instrument Configuration 
program.

Warning page 46

DAC 2 not configured, but present. Please check 
configuration using the Server Configuration program.

Warning page 46
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Error opening VWD-xxx@USB-xxxx – The System 
cannot find the file specified.

Abort page 47

Error reading from VWD-xxxx@USB-xxxx. Abort page 47

Error issuing control request to VWDxxx@USB-xxxxx. Abort page 47

Error reading from VWD-xxxx@USB-xxxxx Data error 
(cyclic redundancy check).

Abort page 48

Filter calibration failed. Abort page 48

Lamp spectral range, wavelength mismatch. Error page 48

A leak has been detected. Warning page 49

Low lamp intensity. Warning page 49

Next qualification of this module is due in x day(s) (due 
date is [date]).

Warning page 50

Next qualification of this module was due on [date]. 
Allowing x more grace day(s).

Warning page 50

Next qualification of this module is overdue (due date 
was [date]).

Warning page 50

Next qualification of this module is overdue (due date 
was [date]). Module may no longer be used.

Error page 50

Next service of this module is due in x day(s) (due date 
is [date]).

Warning page 50

Next service of this module is overdue (due date was 
[date]).

Error page 50

Unsuitable flow cell position. Warning page 51

UV lamp ignition failed. Abort page 51

UV lamp intensity low. Warning page 51

VIS lamp ignition failed. Abort page 52

VIS lamp intensity low. Warning page 52

VWD configured but not present. Please check 
configuration using the Instrument Configuration 
program.

Warning page 52

VWD configured but not present. Please check 
configuration using the Server Configuration program.

Warning page 52

Dionex VWD-Related Audit Trail Error Message Default 
Severity Level

See
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This error occurs if the relative intensity of the deuterium or tungsten lamp (as 
compared to the reference intensity) falls below the value set by the 
UVRelIntensity.Limit or VISRelIntensity.Limit parameter.

To troubleshoot:

1. If your application is not overly sensitive to noise, reduce the value of the 
lamp relative intensity limit (UVRelIntensity.Limit or 
VISRelIntensity.Limit command) in the Chromeleon 7 Command 
window or Chromeleon 6.8 Commands dialog box. 

The default limit is 50%. Some applications can be run when the lamp 
intensity is as low as 20%. However, other applications are extremely 
sensitive to noise and the limit may need to be set higher than the default.

2. Replace the deuterium lamp (P/N 066347) (see Section 5.3) or the 
tungsten lamp (P/N 066348) (see Section 5.4).

VWD-xxxx@USB-xxxxx - Device not found on the USB. Abort page 54

The Warning threshold must be higher than the Limit 
threshold.

Error page 53

The Warning threshold must be lower than the Limit 
threshold.

Error page 53

Wavelength calibration failed. Abort page 54

You do not have the privilege to change the 
performance limits.

Error page 54

You do not have the privilege to change the 
qualification intervals.

Error page 54

You do not have the privilege to approve the module’s 
qualification.

Error page 54

The counter UVRelIntensity (value: x%) has fallen below its 
limit (x%). Module should no longer be used. Replace the UV 
lamp.

The counter VISRelIntensity (value: x%) has fallen below its 
limit (x%). Module should no longer be used. Replace the VIS 
lamp.

Dionex VWD-Related Audit Trail Error Message Default 
Severity Level

See
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This error occurs if the number of hours the deuterium or tungsten lamp has 
been in use exceeds the value set by the UVLampOperationTime.Limit or 
VISLampOperationTime.Limit parameter.

To troubleshoot:

1. If your application is not overly sensitive to noise, increase the value of 
the lamp operation time limit (UVLampOperationTime.Limit or 
VISLampOperationTime.Limit command) in the Chromeleon 7 
Command window or Chromeleon 6.8 Commands dialog box. 

The default limit is 2500 hours. However, some applications are more 
sensitive to noise and the default limit should not be changed.

2. Replace the deuterium lamp (P/N 066347) (see Section 5.3) or the 
tungsten lamp (P/N 066348) (see Section 5.4).

 

To troubleshoot:

1. Turn the Dionex VWD power off and back on again. 

2. If the message occurs again, contact Thermo Fisher Scientific for 
assistance.

The counter UVLampOperationTime (value: x hours) has 
exceeded its limit (x hours). Module should no longer be 
used. Replace the UV lamp.

The counter VISLampOperationTime (value: x hours) has 
exceeded its limit (x hours). Module should no longer be 
used. Replace the VIS lamp.

Critical module failure. 

DAC 1 configured, but not present. Please check 
configuration using the Instrument Configuration program. 

DAC 1 configured, but not present. Please check 
configuration using the Server Configuration program. 

DAC 2 configured, but not present. Please check 
configuration using the Instrument Configuration program. 
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This error occurs when a DAC plug-in module is configured in the 
Chromeleon 7 instrument or Chromeleon 6.8 timebase, but the software 
cannot establish communication with it. 

To troubleshoot:

1. Verify that the DAC plug-in module is installed correctly (see 
Section B.7).

2. If a DAC plug-in module is not installed in the detector, remove it from 
the configuration:

In the Chromeleon 7 Instrument Configuration program or Chromeleon 
6.8 Server Configuration program, go to the Detector tab page of the 
Dionex VWD Properties dialog box. Clear the DAC Board check box 
and click OK.

This error occurs when a DAC plug-in module is installed in the detector, but 
it is not configured in the Chromeleon 7 instrument or Chromeleon 6.8 
timebase. 

To troubleshoot:

In the Chromeleon 7 Instrument Configuration program or Chromeleon 6.8 
Server Configuration program, go to the Detector tab page of the Dionex 
VWD Properties dialog box. Select the DAC Board check box and click OK.

DAC 2 configured, but not present. Please check 
configuration using the Server Configuration program. 

DAC 1 not configured, but present. Please check 
configuration using the Instrument Configuration program. 

DAC 1 not configured, but present. Please check 
configuration using the Server Configuration program. 

DAC 2 not configured, but present. Please check 
configuration using the Instrument Configuration program. 

DAC 2 not configured, but present. Please check 
configuration using the Server Configuration program. 
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These errors occur if the USB connection between the detector and the 
Chromeleon instrument controller or server is interrupted, or the power 
supply to the detector is interrupted.

To troubleshoot:

1. Check the USB connection (see Section B.8.2).

2. Check the power connection to the detector (see Section B.9).

The Chromeleon instrument controller or server cannot connect to the 
specified detector. 

To troubleshoot:

1. Check the USB connection (see Section B.8.2).

2. Check the power connection to the detector (see Section B.9).

3. Verify that the detector is correctly configured in the Chromeleon 7 
instrument or Chromeleon 6.8 timebase:

• In the Chromeleon 7 Instrument Configuration program or 
Chromeleon 6.8 Server Configuration program, go to the General tab 
page of the Dionex VWD Properties dialog box.

• Turn off Virtual Mode, if it is on.

• Click the Browse button and select the Dionex VWD from the Device 
List.

Error opening VWD-xxx@USB-xxxx – The System cannot find 
the file specified.

Error reading from VWD-xxxx@USB-xxxx.

Error issuing control request to VWDxxx@USB-xxxxx.
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There is a transmission error between the detector and the Chromeleon 
instrument controller or server.

To troubleshoot:

Check the USB connection (see Section B.8.2). The connection to the next 
hub must not exceed 5 m (5.5 yd). The overall connection length, including 
the hub connections, must not exceed 30 m (32 yd).

This error may be due to one of the following:

• The lamp(s) were not turned on when calibration was attempted.

• An error occurred during acquisition of the calibration data.

To troubleshoot:

1. Verify that the lamps are on.

2. Check the flow cell connections. 

This error occurs if the selected wavelength is not within the spectral range of 
the active lamp.

To troubleshoot:

Turn on the other lamp or select a different wavelength (see the table below).

Error reading from VWD-xxxx@USB-xxxxx Data error (cyclic 
redundancy check).

Filter calibration failed. 

Lamp spectral range, wavelength mismatch. 

Wavelengths Lamp Required

<345.0 nm UV

>670.0 nm VIS

Between 345.0 and 670.0 nm UV or VIS (or both)

<345.0 nm and >670.0 nm UV and VIS
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The leak sensor is installed in the leak tray inside the detector compartment 
(see Figure 2-3). If liquid accumulates in the tray, the sensor signals the 
problem and this error message appears.

To troubleshoot:

1. Locate the source of the leak by visually inspecting the tubing, fittings, 
and flow cell.

2. Tighten fittings (or replace tubing and fittings) as required (see 
Section 5.1).

3. If the flow cell continues to leak after resuming operation, replace the cell 
(see Section 5.6).

4. After fixing the leak, use a cloth or tissue to wipe up all liquid from the 
drip tray and dry the leak sensor.

5. Clear the ALARM LED (see Section 4.2).

This error occurs when the intensity of the lamp is too low, compared to the 
reference intensity.

To troubleshoot:

1. If your application is not overly sensitive to noise, reduce the value of the 
lamp relative intensity limit (UVRelIntensity.Limit or 
VISRelIntensity.Limit command) in the Chromeleon 7 Command 
window or Chromeleon 6.8 Commands dialog box. 

The default limit is 50%. Some applications can be run when the lamp 
intensity is as low as 20%. However, other applications are extremely 
noise sensitive and the limit may need to be set higher than the default.

2. Replace the deuterium lamp (P/N 066347) (see Section 5.3) or tungsten 
lamp (P/N 066348) (see Section 5.4).

3. If the error appears again, contact Thermo Fisher Scientific for assistance. 
The detector optics may be defective.

A leak has been detected. 

Make sure that you do not bend or damage the sensor.

Low lamp intensity. 



Dionex VWD Operator’s Manual

50 Doc. 065377-01 1/12

Chromeleon monitors the date qualification was last performed and displays 
an appropriate message (shown above) at the following times: when the due 
date for the next qualification is approaching; when the due date is overdue, 
but the detector can still be used; and when the due date is overdue and the 
detector can no longer be used. 

• The Qualification.WarningPeriod parameter determines how many 
days before the due date the first warning appears. 

• The Qualification.GracePeriod parameter determines for how many 
days after the due date the detector can still be used without performing 
the qualification.

To troubleshoot:

Contact Technical Support for Dionex products to schedule an Operational 
Qualification and Performance Qualification.

Chromeleon monitors the date service was last performed on the detector and 
displays an appropriate message (shown above) at the following times: when 
the due date for the next service is approaching and when the due date is 
overdue. The Service.WarningPeriod parameter determines the number of 
days before the due date that the first warning appears. 

To troubleshoot:

Contact Technical Support for Dionex products for information about 
performing preventive maintenance.

Next qualification of this module is due in x day(s) (due date 
is [date]). 

Next qualification of this module was due on [date]. Allowing 
x more grace day(s).

Next qualification of this module is overdue (due date was 
[date]).

Next qualification of this module is overdue (due date was 
[date]). Module may no longer be used.

Next service of this module is due in x day(s) (due date is 
[date]). 

Next service of this module is overdue (due date was [date]).
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This error may occur when the flow cell is incorrectly installed, thereby 
causing the deviation of the calibrated wavelength to be too high for the 
measurement and reference channels. 

To troubleshoot:

Make sure the flow cell is installed correctly (see Section 5.6).

This message may appear if the deuterium lamp fails during operation.

To troubleshoot:

1. Turn the lamp off and on again. 

2. Replace the deuterium lamp (P/N 066347) (see Section 5.3).

This error occurs when the intensity of the deuterium lamp is too low, 
compared to the reference intensity.

To troubleshoot:

1. If your application is not overly sensitive to noise, reduce the value of the 
lamp relative intensity limit (UVRelIntensity.Limit command) in the 
Chromeleon 7 Command window or Chromeleon 6.8 Commands dialog 
box. 

The default limit is 50%. Some applications can be run when the lamp 
intensity is as low as 20%. However, other applications are extremely 
sensitive to noise and the limit may need to be set higher than the default.

2. Replace the deuterium lamp (P/N 066347) (see Section 5.3).

3. If the error appears again, contact Technical Support for Dionex products 
for assistance. The detector optics may be defective.

Unsuitable flow cell position. 

UV lamp ignition failed. 

UV lamp intensity low. 
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This message may appear if the tungsten lamp fails during operation.

To troubleshoot:

1. Turn the lamp off and on again. 

2. Replace the tungsten lamp (P/N 066348) (see Section 5.4).

This error occurs when the intensity of the tungsten lamp is too low, compared 
to the reference intensity.

To troubleshoot:

1. If your application is not overly sensitive to noise, reduce the value of the 
lamp relative intensity limit (VISRelIntensity.Limit command) in the 
Chromeleon 7 Command window or Chromeleon 6.8 Commands dialog 
box. 

The default limit is 50%. Some applications can be run when the lamp 
intensity is as low as 20%. However, other applications are extremely 
sensitive to noise and the limit may need to be set higher than the default.

2. Replace the tungsten lamp (P/N 066348) (see Section 5.4).

3. If the error appears again, contact Technical Support for Dionex products 
for assistance. The detector optics may be defective.

This error occurs if the Dionex VWD is configured in the Chromeleon 7 
instrument or the Chromeleon 6.8 timebase, but the software cannot establish 
communication with the detector.

To troubleshoot:

1. Verify that the Dionex VWD power is on.

VIS lamp ignition failed. 

VIS lamp intensity low. 

VWD configured but not present. Please check configuration 
using the Instrument Configuration program.

VWD configured but not present. Please check configuration 
using the Server Configuration program.
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2. Verify that the detector is correctly configured:

• In the Chromeleon 7 Instrument Configuration program or 
Chromeleon 6.8 Server Configuration program, go to the General tab 
page of the Dionex VWD Properties dialog box.

• Turn off Virtual Mode, if it is on.

• Click the Browse button and select the Dionex VWD from the Device 
List.

This message appears if you attempt to set a Warning value for certain 
parameters (for example, UVLampRelIntensity or VISLampRelIntensity) 
that is lower than the Limit value. Chromeleon issues a warning message in 
the Audit Trail when the Warning value is reached and an error message when 
the Limit value is reached.

To troubleshoot:

Select a Warning value that is higher than the Limit value.

This message appears if you attempt to set a Warning value for certain 
parameters (for example, UVLampOperationTime or 
VISLampOperationTime) that is higher than the Limit value. Chromeleon 
issues a warning message in the Audit Trail when the Warning value is 
reached, and an error message when the Limit value is reached.

To troubleshoot:

Select a Warning value that is lower than the Limit value.

The Warning threshold must be higher than the Limit 
threshold. 

The Warning threshold must be lower than the Limit 
threshold. 
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This message may appear if the lamp(s) are not turned on when calibration is 
attempted.

To troubleshoot:

1. Verify that the lamps are on, and then retry the calibration.

2. Turn the Dionex VWD power off and on again. 

3. If the message appears again, contact Technical Support for Dionex 
products for assistance.

This error can occur if the USB connection between the detector and the 
Chromeleon instrument controller or server is interrupted, or the power 
supply to the detector is interrupted.

To troubleshoot:

1. Check the USB connection (see Section B.8.2).

2. Check the power connection to the detector (see Section B.9).

The Chromeleon administrator assigns various types of privileges to 
individual users or to user groups. Contact the administrator if you need one 
or more of the above privileges assigned to you.

Wavelength calibration failed. 

VWD-xxxx@USB-xxxxx - Device not found on the USB.

You do not have the privilege to change the performance 
limits. 
You do not have the privilege to change the qualification 
intervals.
You do not have the privilege to approve the module’s 
qualification.
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4.2 ALARM LED Is Lighted

• Leak sensor in drip tray may have been triggered

Check the Chromeleon Audit Trail for a leak-related error message. Find and 
eliminate the source of the leak. 

After fixing the leak and drying the sensor, clear the ALARM LED.

In the Chromeleon 7 Command window: Click UV, click the Commands tab, 
and click the button next to ClearAlarmLED.

On the Chromeleon 6.8 Control panel: Under Alarm LED, click the Clear 
button.

4.3 No Detector Response

• Detector power not on

Check that the power cord is connected from the Dionex VWD rear panel to a 
power source.

Check that the main power switch is turned on.

Check the fuses and replace them, if necessary (see Section 5.7).

• Lamp not turned on

Turn on the lamp from either Chromeleon or the TTL input. When a lamp is 
on, the corresponding front status bar LED (Deuterium or Tungsten) is 
lighted.

• Detector not connected to the instrument or timebase

For Chromeleon 7: Add the Dionex VWD device driver to an instrument in 
the Instrument Configuration program (see Section B.11.1).

For Chromeleon 6.8: Add the Dionex VWD device driver to a timebase in the 
Server Configuration program (see Section B.11.2).

• Windows operating system does not recognize Dionex VWD

When the PC is turned on, Windows scans the network for unknown devices. 
If the Dionex VWD power is off, the detector cannot be identified. Also, if 
you connect the Dionex VWD to the PC before installing Chromeleon, the 
detector cannot be identified. Refer to Section 4.9 to solve the problem.
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4.4 Lamp Does Not Light

• Lamp is old or burned out

Replace the lamp. For deuterium lamp (P/N 066347) installation instructions, 
see Section 5.3. For tungsten lamp (P/N 066348) installation instructions, see 
Section 5.4.

4.5 Noisy Baseline

• Mobile phase or post-column reagent is degraded

Prepare all mobile phases and reagents with spectro-grade solvents, reagent-
grade chemicals, and ASTM Type I (18 megohm-cm) filtered, deionized 
water that meets the specifications listed in Table B-1.

• Leaking fittings

Locate the source of the leak. Tighten (or replace) all liquid line connections 
(see Section 5.1).

• Insufficient time for system equilibration after turning on lamp(s)

To achieve optimum results, allow 60 minutes for the lamp(s) to stabilize 
before beginning operation.

• Strongly-retained components from previous analysis are slowly eluting

To elute strongly-retained species, use a stronger mobile phase. Re-equilibrate 
with the standard mobile phase before resuming routine operation.

Clean the column as instructed in the column manual. Column manuals are 
shipped on the Thermo Scientific Reference Library DVD (P/N 053891). If 
the problem persists, refer to the column manual for troubleshooting 
guidance.

• Plot scale exaggerates baseline noise

If autoscale is selected, even a plot with low noise may fill the screen. Check 
the Y-axis scale values.

• Pump needs priming and/or maintenance

If the baseline noise is synchronized with the pump stroke, reprime the pump. 
The piston seals and/or check valves may also need to be cleaned. Refer to the 
pump or system operator’s manual for instructions. Pump and system 
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operator’s manuals are shipped on the Thermo Scientific Reference Library 
DVD (P/N 053891).

• Air bubbles in flow cell

To prevent air from becoming trapped in the cell, follow these steps:

• Degas mobile phases and post-column reagents by vacuum degassing 
or sparging with helium.

• Connect a backpressure line to the cell (see Section B.4). This 
increases the backpressure on the cell, thereby shrinking bubbles and 
allowing them to pass more easily through the cell.

• Contaminants in flow cell

Clean the cell (see Section 5.5).

• Lamp needs replacement

The light output of the lamp decreases over time. The lower light output may 
increase noise above an acceptable level, especially if the lamp has been in 
service for more than 2000 hours. If this occurs, replace the lamp. For 
deuterium lamp (P/N 066347) installation instructions, see Section 5.3. For 
tungsten lamp (P/N 066348) installation instructions, see Section 5.4.

• Lamp incorrectly installed

Make sure that both lamps are fully seated in the optical bench. For deuterium 
lamp (P/N 066347) installation instructions, see Section 5.3. For tungsten 
lamp (P/N 066348) installation instructions, see Section 5.4.

• Front cover or lamp cover is missing

Optical components are sensitive to temperature and light. Do not operate the 
Dionex VWD unless the front cover and lamp cover are in place.

• Crimped or plugged tubing

Over time, tubing may become pinched off and plugged. Periodically check 
all tubing and replace as needed (see Section 5.1).

• Flow cell installed incorrectly

Check that the cell is inserted straight into the optical bench and is fully 
seated.
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• Detector exposed to high vibration

Optical detectors are sensitive to vibrations. Make sure the Dionex VWD 
installation site is vibration-free.

• The data collection rate is too fast

Decrease the data collection rate (see Section 3.5.2). 

• The Average parameter is turned off

The Average parameter operates with the Step parameter. A step is the time 
interval between two successively stored data points. When you select a Data 
Collection Rate, Chromeleon 6.8 automatically sets the step value to the 
reciprocal of the data collection rate at the start of data acquisition.

When Average is on (the default setting), Chromeleon 6.8 averages the data 
points between step intervals and reports that value. This typically reduces 
noise. 

When Average is off, Chromeleon 6.8 reports only the last data point of the 
step interval. The data points between steps are skipped. Noise is not reduced 
in this case.

To verify the Average parameter setting: In the Commands dialog box, scroll 
to the signal name (for example, UV_VIS_1). Click the plus sign to expand 
the list of commands and parameters for the signal.

4.6 Drifting Baseline

• Fluctuations in ambient temperature

Make sure the Dionex VWD installation site temperature remains consistent. 
Allow at least 6 cm (2.4 in) of clearance behind the Dionex VWD for 
ventilation. 

• Mobile phase or post-column reagent is degraded

Prepare all mobile phases and reagents with spectro-grade solvents, reagent-
grade chemicals, and ASTM Type I (18 megohm-cm) filtered, deionized 
water that meets the specifications listed in Table B-1.

• Front cover or lamp cover is missing

Optical components are sensitive to temperature and light. Do not operate the 
Dionex VWD unless the front cover and lamp cover are in place. 
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• Insufficient time for system equilibration after turning on lamp(s)

To achieve optimum results, allow 60 minutes for the lamp(s) to stabilize 
before beginning operation.

• Leaking flow cell

Tighten fittings. Also, check that the backpressure on the cell does not exceed 
the specification (see Section A.5). 

If the cell continues to leak, replace it (see Section 5.6).

• Lamp needs replacement

The light output of the lamp decreases over time. The lower light output may 
increase noise above an acceptable level or cause baseline drift, especially if 
the lamp has been in service for more than 2000 hours. If this occurs, replace 
the lamp. For deuterium lamp (P/N 066347) installation instructions, see 
Section 5.3. For tungsten lamp (P/N 066348) installation instructions, see 
Section 5.4.

4.7 Peak Broadening

• Tubing inner diameter too large

Refer to Section 5.1 for tubing requirements for the cell inlet and outlet 
tubing. Replace tubing if needed. 

• Mobile phase or post-column reagent is degraded

Prepare all mobile phases and reagents with spectro-grade solvents, reagent-
grade chemicals, and ASTM Type I (18 megohm-cm) filtered, deionized 
water that meets the specifications listed in Table B-1.

• System-level problem

1. Check the system for blocked tubing.

2. The column may be overloaded. Reduce the sample size or dilute the 
sample.

3. The column may be contaminated. Clean or replace the column.

4. The end-line filters on the mobile phase lines are clogged. Replace the 
filters.
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• Worn or damaged column

Replace the column.

4.8 Poor Reproducibility

Poor reproducibility is generally caused by a system-level problem and is not 
related to detector performance. Some examples of system-level problems that 
may cause poor reproducibility follow. Refer to the system manual or individual 
module manual (autosampler, pump, etc.) for additional causes and 
troubleshooting information. System and module manuals are shipped on the 
Thermo Scientific Reference Library DVD (P/N 053891).

• The autosampler is drawing air from the vial, or there are air bubbles in the 
syringe.

• Sample carryover is occurring.

• There is air in the flow path.

• Fitting connections to the tubing are not tightened properly.

• The pump piston seals need to be replaced.

• The mobile phase is not properly degassed.

• The sample is unstable.

• The gradient is not reproducible.

• The environmental conditions (temperature and/or humidity) are fluctuating.
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4.9 Faulty USB Communication

• Dionex VWD not recognized by Windows operating system

Dionex strongly recommends installing Chromeleon before connecting the 
Dionex VWD to the PC. When the chromatography software is installed first, 
USB driver information is loaded automatically. If Windows fails to detect the 
Dionex VWD, refer to the table below for corrective action.

Problem Action

Windows Vista fails to detect 
the Dionex VWD and 
launches a wizard instead 

This indicates that you connected the Dionex 
VWD to the PC and turned on the power for the 
first time before you installed Chromeleon. To 
resolve the problem:

• Click Cancel to exit the wizard.

• Turn off the detector and unplug the USB 
cable from the PC. 

• Install Chromeleon. 

• Reconnect the USB cable to the PC and turn 
on the power to the detector.

• Windows Vista will now detect the Dionex 
VWD and automatically install the USB 
software for it. 

Windows XP fails to detect 
the Dionex VWD and a 
message box asks for a USB 
configuration file 
(CmWdmUsb.inf) 

This indicates that you connected the Dionex 
VWD to the PC and turned on the power for the 
first time before you installed Chromeleon. To 
resolve the problem:

• Click Cancel in the Windows message box. 

• Turn off the detector power and unplug the 
USB cable from the PC. 

• Install Chromeleon. 

• Reconnect the USB cable to the PC and turn 
on the power to the detector. 

• Windows will now automatically detect the 
Dionex VWD and launch the Found New 
Hardware Wizard. 
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5 • Service

This chapter describes Thermo Scientific Dionex ICS Series Variable Wavelength 
Detector (Dionex VWD) service and repair procedures that users may perform. 
All procedures not included here, including electronics-related repair procedures, 
must be performed by Thermo Scientific personnel. For assistance, contact 
Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-
6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific 
office.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to 
correctly identify the cause of the problem.

5.1 Replacing Tubing and Fittings

Use the tubing and fittings listed below to plumb the Dionex VWD. 

Double-cone 10-32 ferrule fittings (P/N 043276) and 10-32 bolts (P/N 043275) 
are used for all tubing connections.
 

Substituting non-Dionex/Thermo Fisher Scientific parts may impair a
module’s performance, thereby voiding the product warranty. Refer to
the warranty statement in the Dionex Terms and Conditions for more
information.

Tubing Size and Type Color P/N Used For

0.125-mm (0.020-in) ID 
PEEK

Orange 052308 
(20 ft)

Cell outlet (waste) line

0.25-mm (0.010-in) ID 
PEEK

Black 052306 
(5 ft)

Backpressure line
Cell inlet line from the column 
(standard bore systems)

0.125-mm (0.005-in) ID 
PEEK

Red 052311 
(20 ft)

Cell inlet line from the column 
(microbore systems)

Keep in mind that the fluid components of the detector may be filled
with toxic solvents. Therefore, purge the detector with an appropriate
solvent and put on protective clothing before starting maintenance or
repair work.
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5.2 Wavelength Calibration and Verification

Wavelength calibration is performed automatically at the following times:

• When a detector lamp is turned on for the first time after the detector power is 
turned on. 

• After the detector resumes operation from standby mode. 

Calibration starts shortly after the lamp is ignited. The 0-order position of the 
grating is established; this is the point where the grating is positioned to reflect all 
light from the lamps without diffraction. It is used as the “home” position for the 
grating.

In addition, the wavelength accuracy can be verified via the holmium oxide filter 
installed in the beam path of the lamp. The maxima are determined from the 
resulting transmission spectrum and compared to the holmium oxide values stored 
in the detector firmware. 

At a minimum, wavelength verification should be performed after changing the 
flow cell. Perform wavelength verification more often if your application is very 
sensitive to wavelength variations.

Before verifying wavelengths, observe the following precautions:

• Allow enough time (typically 15 minutes) to ensure that each lamp has 
reached the operating temperature. A lamp’s spectrum changes significantly 
during the first few minutes after the lamp is turned on.

• Make sure the baseline is stable. The baseline may become unstable if the 
solvent composition has been modified, or if air bubbles exist in the light 
path.

Gardez à l'esprit que les circuits hydrauliques du détecteur peuvent
être remplis de solvants toxiques. Par conséquent, purgez le
détecteur avec un solvant approprié et portez des vêtements de
protection avant de commencer les opérations de maintenance ou de
réparation.

Bedenken Sie, dass die fluidischen Bauteile des Detektors eventuell
mit giftigen Lösungsmitteln gefüllt sind. Spülen Sie daher vor Beginn
der Wartungsarbeiten den Detektor mit einem geeigneten
Lösungsmittel und tragen Sie Schutzkleidung
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• Verify that the solvent flowing through the cell is not strongly absorbing in the 
wavelength range to be verified. This will be the case, for example, if the cell 
is filled with a mixture of 96% hexane and 4% ethyl acetate.

To perform wavelength verification:

1. In the Chromeleon 7 Command window: Click UV, click the Commands tab, 
and click the button next to the WavelengthVerTest command.

In the Chromeleon 6.8 Commands dialog box: Click the plus sign next to UV, 
click the WavelengthVerTest command, and click Execute.

• The accuracy is verified for the following wavelengths: 360.9, 418.8, and 
536.5. The results of the test (pass or fail) are logged in the Audit Trail.

• Wavelength verification can take up to 2 minutes. During this time, data 
acquisition is not possible.

2. If verification fails, perform wavelength calibration:

a. Open the Command window or Commands dialog box.

b. Execute the WavelengthCalibration command.

5.3 Replacing a Deuterium Lamp

NOTE The typical lifetime of a deuterium lamp is 2000 hours.

1. Turn off the pump flow from the Chromeleon 7 ePanel Set or the Chromeleon 
6.8 Control panel.

2.  Stop the Chromeleon server.

3. Turn off the Dionex VWD power switch on the rear panel (see Figure 2-5).

The deuterium lamp emits UV radiation that is harmful to the eyes.
Always turn off the detector power before removing the lamp cover. 

La lampe deuterium emettet de rayons ultraviolets, qui sont
dangeroux pour les yeux. Voulez vous etteindre le detecteur avant
d'enlever le couvercle de la lampe.

Die Deuteriumlampe gibt UV-Strahlung ab; diese ist schädlich für die
Augen. Schalten Sie den Detektor immer aus, ehe Sie die Abdeckung
von der Lampe entfernen. 
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4. Grasp the detector front cover by the sides and pull straight off to remove it.

5. Loosen the screw holding the lamp housing cover in place (see Figure 5-1) by 
one-quarter turn. Remove the cover and set it aside.

The lamp housing and base may be hot to the touch, especially after
the lamp has been in operation for a long time. Wait until the lamp has
cooled before continuing.

La lampe et la base de la lampe peuvent être chaudes au toucher,
particulièrement après que la lampe a été allumée pendant longtemps.
Attendez que la lampe ait refroidi avant de continuer.

Das Lampengehäuse und die Lampenbefestigung können sehr heiß
werden, besonders wenn die Lampe längere Zeit in Betrieb war.
Warten Sie, bis die Lampe abgekühlt ist, bevor Sie diese berühren.

Figure 5-1.  Lamp Housing Cover

Loosen this 
screw
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6. Squeeze the clip on the deuterium lamp connector (see Figure 5-2) and pull 
out the connector from its source.

7. Loosen the two screws in the lamp flange (see Figure 5-3) and pull out the 
lamp.

8. Inspect the new deuterium lamp (P/N 066347) for fingerprints and dust. If 
necessary, clean the lamp with isopropanol (IPA).

Figure 5-2.  Deuterium Lamp, Connector, and Clip

Figure 5-3.  Deuterium Lamp Screws and Locating Pin

Deuterium Lamp Lamp Connector Connector Clip

Loosen these
screws

Locating Pin
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9. Align the flange of the new lamp with the locating pin (see Figure 5-3), and 
then gently push the lamp into the lamp housing. When the lamp is seated, 
tighten the screws in the flange. 

10. Squeeze the clip on the deuterium lamp connector and reconnect it to its 
source.

11. Reinstall the lamp housing cover.

12. Replace the detector front cover.

13. Turn on the detector power. 

The lamp age counter (UVLampOnTime) is automatically reset to the value 
stored on the lamp's chip card.

14. Start the Chromeleon server.

15. Start the pump flow and turn on the lamp.

NOTE Allow the new deuterium lamp to run for at least
24 hours before the first analysis. During this time,
strong baseline fluctuations and increased noise may
occur.

You can use the Smart Startup feature in Chromeleon 7
or Chromeleon 6.8 to monitor the detector signal and
notify you when the detector is ready for operation. For
details, refer to the Chromeleon Help.

To ensure proper performance, the lamp must be fully seated. 
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5.4 Replacing a Tungsten Lamp

NOTE The typical lifetime of a tungsten lamp is 2000 hours.

1. Turn off the pump flow from the Chromeleon 7 ePanel Set or the Chromeleon 
6.8 Control panel.

2. Stop the Chromeleon server.

3. Turn off the Dionex VWD power switch on the rear panel (see Figure 2-5).

4. Grasp the detector front cover by the sides and pull straight off to remove it.

5. Loosen the screw holding the lamp housing cover in place (see Figure 5-4) by 
one-quarter turn. Remove the cover and set it aside.

The lamp housing and base may be hot to the touch, especially if the
lamp has been in operation for a long time. Wait until the lamp has
cooled before continuing.

La lampe et la base de la lampe peuvent être chaudes au toucher,
particulièrement après que la lampe a été allumée pendant longtemps.
Attendez que la lampe ait refroidi avant de continuer.

Das Lampengehäuse und die Lampenbefestigung können sehr heiß
werden, besonders wenn die Lampe längere Zeit in Betrieb war.
Warten Sie, bis die Lampe abgekühlt ist, bevor Sie diese berühren.

Figure 5-4.  Lamp Housing Cover

Loosen this 
screw
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6. Squeeze the clip on the tungsten lamp connector (see Figure 5-5) and pull out 
the connector from its source.

7. Loosen the two screws in the lamp flange (see Figure 5-6) and pull out the 
lamp.

8. Align the new tungsten lamp (P/N 066348) with the locating pin (see 
Figure 5-6), and then gently push the lamp into the lamp housing. When the 
lamp is seated, tighten the screws in the flange.

9. Reinstall the lamp housing cover.

Figure 5-5.  Tungsten Lamp, Connector, and Clip

Figure 5-6.  Tungsten Lamp Screws and Locating Pin

Tungsten Lamp Lamp Connector Connector Clip

Loosen these
screws

Locating Pin
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10. Replace the detector front cover.

11. Turn on the detector power. 

The lamp age counter (VISLampOnTime) is automatically reset to the value 
stored on the lamp's chip card.

12. Start the Chromeleon server.

13. Start the pump flow and turn on the lamp.

NOTE After replacing the lamp, increased noise and strong
baseline fluctuations may occur. Before beginning an
analysis, allow the new lamp to run until the noise is
reduced and the baseline is stable.

You can use the Smart Startup feature in Chromeleon 7
or Chromeleon 6.8 to monitor the detector signal and
notify you when the detector is ready for operation. For
details, refer to the Chromeleon Help.

5.5 Cleaning the Flow Cell

Occasionally, eluted compounds may be deposited on the cell walls, thus 
increasing the detector noise level. 

To clean the flow cell, pump methanol through the cell and observe the baseline. 

If this procedure does not clean the cell, follow the steps below.
  

1. Flush the flow cell with 0.1M nitric acid. 

To avoid damage to the skin and eyes, wear appropriate protective
clothing and goggles when using nitric acid.

Afin d'éviter des brûlures cutanées ou oculaires, portez des
vêtements de protection appropriés et des lunettes de protection
lorsque vous utilisez de l'acide nitrique.

Um Verletzungen an Augen und Haut zu vermeiden, sollten Sie beim
Umgang mit Salpetersäure stets geeignete Schutzkleidung und eine
Schutz-brille tragen.
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2. Flush the flow cell with deionized water until the solvent exiting the cell is 
neutral (pH 7).

5.6 Replacing the Flow Cell

5.6.1 Remove the Flow Cell

1. Unclip the cell inlet and outlet line unions (see Figure 5-7).

2. While holding the inlet union in place, disconnect the cell inlet line 
from the union.

NOTE Be careful not to twist, kink, or put other stress
on the factory-installed lines and connectors to
the flow cell IN and OUT ports. 

3. Repeat Step 2 to disconnect the cell outlet line.

4. Loosen the two flow cell screws.

5. Pull the flow cell out of the detector.

When the flow cell is removed, light (at the wavelength set for the
detector) emits from the opening to the left of the flow cell. To avoid
possible damage to the eyes, turn off the lamps, turn off the power to
the detector, wear UV goggles, or set the wavelength to 600 nm or
above.

Figure 5-7.  Removing the Flow Cell

Cell Inlet and
Outlet Line

Unions

Flow Cell 
Screws
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5.6.2 Install the Flow Cell

NOTE Contacts for the flow cell identification chip are located
on the rear of the flow cell (see Figure 5-8). To ensure
optimum performance of the chip, be careful not to
touch the contacts.

1. Orient the new flow cell (standard cell, P/N 066346; semi-micro cell, 
P/N 6074.0300) with the cell inlet and outlet unions on the left (see 
Figure 5-7) and push the flow cell into the opening in the detector. 

2. Tighten the two screws.

3. Reconnect the cell inlet and outlet lines to their unions.

4. Push the cell inlet and outlet unions onto the clips to secure them.

NOTE Tubing connections between the column and the flow
cell should be as short as possible to avoid peak
broadening effects due to excessive dead volume. 

5.6.3 Perform Wavelength Verification

After replacing a flow cell, perform wavelength verification (see 
Section 5.2).

Figure 5-8.  Rear of Flow Cell with Identification Chip Contacts

Identification
Chip Contacts

(Do Not Touch)
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5.7 Replacing the Fuses

1. Turn off the main power switch on the rear panel of the detector (see 
Figure 2-5).

2. Disconnect the main power cord from both its source and from the rear panel 
of the detector.

.

3. The fuse cartridge is located next to the main power switch (see Figure 5-9). 
Use a small screwdriver to remove the fuse cartridge.

4. Replace the two fuses with new IEC 60127-2 time lag fuses, rated at 2 A, 
250 VAC (P/N 954776). Thermo Scientific recommends always replacing 
both fuses.

5. Reinstall the fuse cartridge.

6. Reconnect the main power cord to its source and to the detector. Turn on the 
main power switch. 

HIGH VOLTAGE—Disconnect the main power cord from its source and
also from the rear panel of the Dionex VWD.

HAUTE TENSION—Débranchez le cordon d'alimentation principal de
sa source et du panneau arrière du Dionex VWD.

HOCHSPANNUNG—Ziehen Sie das Netzkabel aus der Steckdose und
der Netzbuchse auf der Rückseite des Dionex VWD.

Figure 5-9.  Main Power Switch, Fuse Cartridge, and Power Receptacle

Fuse Cartridge
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A • Specifications

A.1 Electrical

A.2 Environmental

A.3 Physical

Main Power
Requirements

85 to 260 VAC, 47 to 63 Hz (auto-sensing power supply; no 
manual voltage or frequency adjustment required)
Power limit: 150 W maximum

Fuse
Requirements

Two IEC 60127-2 time lag fuses (P/N 954776) rated at 2 A, 
250 VAC

 Operating
Temperature

(Ambient)

10 to 35 °C (50 to 95 °F)

Humidity
(Ambient)

80% maximum relative humidity, noncondensing

Dimensions Height: 15.2 cm (6.0 in)
Width: 44.4 cm (17.5 in)
Depth: 50.3 cm (19.8 in)

Weight 15.4 kg (34 lb)
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A.4 Detector

Optical System Double-beam forward optics design (monochromator)
Dual-wavelength UV-Vis detector

Light Sources Deuterium lamp (for ultraviolet wavelength detection)
Tungsten lamp (for visible wavelength detection)

Wavelength Range 190 to 900 nm

Wavelength
Accuracy

±1 nm (over detector lifetime)

Wavelength
Repeatability

±0.1 nm

Noise (single
wavelength)

<± 3.5 µAU (typical <± 2.5 µAU) under the following conditions: 
Dry (dummy) flow cell, 254 nm, 1 second time constant, 
deuterium lamp on only, 60 minutes or less of warm-up time

< 5.0 µAU (typical) under the following conditions: 
Dry (dummy) flow cell, 520 nm, 1 second time constant, tungsten 
lamp on only, 60 minutes or less of warm-up time

< 7.5 µAU (typical) under the following conditions:
Wet standard cell, 520 nm, flowing methanol at 1.0 mL/min, 
1 second time constant, tungsten lamp on only, 60 minutes or less 
of warm-up time

Noise (dual
wavelength)

<± 25 µAU (typical <± 10 µAU) under the following conditions:
Dry (dummy) flow cell, 254 and 280 nm, 2 second time constant, 
2 Hz data collection rate, deuterium lamp on only, 60 minutes or 
less of warm-up time

< 30 µAU (typical <± 10 µAU) under the following conditions:
Dry (dummy) flow cell, 450 and 520 nm, 2 second time constant, 
2 Hz data collection rate, tungsten lamp on only, 60 minutes or less 
of warm-up time

< 50 µAU (typical <± 10 µAU) under the following conditions:
Wet standard flow cell, 450 and 520 nm, flowing methanol at 
1.0 mL/min, 2 second time constant, 2 Hz data collection rate, 
tungsten lamp on only, 60 minutes or less of warm-up time
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Drift <1 x 10-4 AU/hour under the following conditions:
Dry (dummy) flow cell, 254 nm, deuterium lamp on only, 
60 minutes or less of warm-up time, constant ambient conditions 
(temperature, humidity) 

<1 x 10-4 AU/hour under the following conditions:
Dry (dummy) flow cell, 520 nm, tungsten lamp on only, 
60 minutes or less of warm-up time, constant ambient conditions 
(temperature, humidity)

Linearity Caffeine: <5% RSD at 2.5 AU at 272 nm based on ASTM
Cobalt: <5% RSD at 2.5 AU at 520 nm based on ASTM

Wavelength
Calibration

Internal calibration with zero order and D-alpha line of the 
deuterium lamp

Wavelength
Verification

Internal verification with holmium oxide filter

Data Collection
Rate (single
wavelength)

Adjustable, up to 10 Hz (single-channel Dionex VWD) or 100 Hz 
(four-channel Dionex VWD)

Data Collection
Rate (multiple

wavelength)

Adjustable, up to 5 Hz, depending on the number of wavelengths 
(2 to 4) and the distance between the wavelengths (in nm)

Optical Bandwidth 6 nm at 254 nm

Identification
System

Storage of identification and status information, including the 
lamp type, serial number, number of lamp starts, lamp age, and 
lamp intensity
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A.5 Flow Cells

A.5.1 Standard Flow Cell

A.5.2 Semi-Micro Flow Cell

Cell Body PEEK

Path Length 10 mm

Cell Volume 11 µL

Maximum
Operating

Pressure

5 MPa (725 psi)

Heat Exchanger Volume of 8.8 µL

Identification
System

Storage of identification information, including serial number

Cell Body PEEK 

Path Length 7 mm

Cell Volume 2.5 µL

Maximum
Operating

Pressure

5 MPa (725 psi)

Heat Exchanger Volume of 5 µL

Identification
System

Storage of identification information, including serial number
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A.6 Digital I/O

A.7 Analog Outputs (Optional)

Inputs Four digital inputs

Outputs Four digital outputs

Output Mode and
Resolution

Absorbance or ratio mode, 20-bit resolution

Full-Scale Voltage
Range

1 V or 10 V

Full-Scale
Response Range

0.1, 1, or 5 AU per full-scale voltage (1 V or 10 V)
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B • Installation

B.1 Facilities Requirements

• Make sure the Thermo Scientific Dionex ICS Series Variable Wavelength 
Detector (Dionex VWD) installation site meets the power and environmental 
specifications listed in Appendix A.

• Optical detectors are sensitive to vibration. Provide a sturdy, vibration-free 
workbench of a height that ensures convenient access to the interior of the 
Dionex VWD.

• Make sure the workbench surface is resistant to solvents.

• Allow at least 6 cm (2.4 in) of clearance behind the Dionex VWD for power 
connections and ventilation.

• Optical detectors are sensitive to changes in temperature and light. Protect the 
detector, column, and all tubing from drafts and direct sunlight. Do not 
operate the detector unless the lamp housing cover and front cover are in 
place.

• For mobile phase generation, or when manually preparing mobile phase and 
regenerant, use ASTM Type I (18 megohm-cm) filtered and deionized water 
that meets the specifications listed in Table B-1.

Contaminant  Specification

Ions–Resistivity  >18.0 (megohm-cm)

Organics–TOC  <10 ppb

Iron/Transition Metals*  <1 ppb

Pyrogens  <0.03 (Eu/mL)

Particulates >0.2 µm  <1 (units/mL)

Colloids–Silica  <10 ppb

Bacteria  <1 (cfu/mL)

* Iron/transition metal content not specified for ASTM Type 
I water

Table B-1. ASTM Filtered, Type I Deionized Water Specifications for IC
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B.2 Positioning the Dionex VWD in the System

The detector can be positioned in various locations within a system, depending on 
the other modules included in the system and the application. For example, you 
can place the Dionex VWD in any of the following positions:

• Above or below a Thermo Scientific Dionex ICS-5000 Thermal 
Compartment or ICS-5000 Detector/Chromatography module

• Below a Thermo Scientific Dionex AS-AP Autosampler

• To the right or left of an integrated system module (for example, a Thermo 
Scientific Dionex ICS-1100 or ICS-1600)

B.3 Unpacking

1. Place the shipping container on the floor and open the container from the top.

2. Remove the foam spacer and the Dionex VWD Ship Kit (P/N 064787).

3. Using the handholds in the cardboard cradle, lift the detector out of the 
shipping container and place it on the bench.

4. Raise the front of the detector about 5 cm (2 in) and remove the cardboard 
cradle.

5. Remove the polyethylene bag.

NOTE Keep the original shipping container and all packing
material. These will be needed if the detector is ever
shipped or is moved to a new location. 

6. Check that the main power switch on the rear panel is turned off.

7. Loosen the two shipping locks on the bottom of the detector (see Figure B-1). 
These locks secure the detector optics. 
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8. Before connecting the detector to the power supply, wait approximately 
4 hours to allow the detector to come to room temperature and to allow any 
condensation to evaporate. 

After 4 hours, check the detector; if condensation still exists, allow the 
detector to continue to warm up (without connecting it to the power source) 
until the condensation is completely gone.

Figure B-1.  Detector Shipping Locks

Loosen these 
locks.
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B.4 Installing the Flow Cell

A dummy flow cell is installed in the detector before shipping. Before initial 
operation of the detector, replace the dummy cell with a flow cell.

NOTE Keep the dummy flow cell for reuse. The dummy cell
protects the detector optics during long-term shutdown
or if the detector must be shipped at a later time. 

Removing the Dummy Cell

1. Grasp the Dionex VWD front cover by the sides and pull it straight off to 
remove it.

2. Loosen the two screws that hold the dummy cell in position (see Figure B-2) 
and pull the cell out of the detector.

Figure B-2.  Removing the Dummy Cell

Loosen these
screws
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Installing a Flow Cell

NOTE Contacts for the flow cell identification chip are located
on the rear of the flow cell (see Figure B-3). To ensure
optimum performance of the chip, do not touch the
contacts.

Figure B-4 shows the flow cell after installation is complete.

Figure B-3.  Rear of Flow Cell with Identification Chip Contacts

Figure B-4.  Flow Cell Installed

Identification
Chip Contacts

(Do Not Touch)

Cell Inlet
and Outlet

Line Unions

Flow Cell 
Inlet

Flow Cell 
Outlet
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Figure B-5 is a schematic of the flow cell tubing connections.

1. Push the flow cell into the opening in the detector and tighten the two 
screws.

2. While holding the inlet union in place (see Figure B-5), unscrew and 
remove the plug on the end of the union. Repeat to remove the plug 
from the outlet union.

NOTE Be careful not to twist, kink, or otherwise put
stress on the factory-installed lines and
connectors to the flow cell IN and OUT ports. 

3. Connect the flow cell inlet tubing:

a. Locate the required tubing in the Dionex VWD Ship Kit 
(P/N 064787). For a standard bore system, locate the 0.25-mm 
(0.010-in) ID black PEEK tubing (P/N 052306). For a microbore 
system, locate the 0.125-mm (0.005-in) ID red PEEK tubing 
(P/N 052311).

b. Cut a length of tubing long enough to connect the union on the 
flow cell inlet to the separator column outlet. 

NOTE Tubing connections between the column and the
flow cell should be as short as possible to avoid

Figure B-5.  Dionex VWD Flow Schematic

IN
O

U
T

Cell Inlet Tubing

Cell Outlet 
Backpressure Tubing

To Separator Column

Cell Waste Tubing

To Waste

Inlet Union

Outlet Union
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peak broadening effects due to excessive dead
volume. 

c. Locate the two red fittings supplied with the cell. Use one fitting 
to connect the inlet tubing to the inlet union. Note: These fittings 
do not use ferrules.

d. Install a double-cone 10-32 ferrule fitting (P/N 043276) and 10-
32 bolt (P/N 043275) on the other end of the inlet tubing and 
connect it to the separator column outlet.

4. Connect a backpressure line to the cell outlet (recommended to 
prevent bubbles from forming in the cell):

a. Cut a length of 0.25-mm (0.010-in) ID black PEEK tubing 
(P/N 052306) to the required length: 1 meter for a flow rate of 
1.0 mL/min, 2 meters for a flow rate of 0.5 mL/min, and so on. 

b. Use the red fitting supplied with the cell to connect one end of the 
tubing to the outlet union.

5. Connect a waste line to the backpressure line:

a. Locate the 0.125-mm (0.020-in) ID orange PEEK tubing in the 
Dionex VWD Ship Kit (P/N 064787). Cut a length long enough 
to connect the backpressure line to the waste container.

b. Install a 10-32 ferrule fitting and bolt on one end of the tubing.

c. Use a union (P/N 042627) to connect this line to the backpressure 
line.

6. Push the inlet and outlet line unions onto the clips.

7. Route the lines to the outside of the detector through the slot provided 
in the enclosure (see Figure 2-3). Direct the waste line to a waste 
container.

Notes for Cutting Tubing

• Use a tubing cutter to cut tubing to the required length. Make sure the 
cut is at a right angle to the length of the tubing and there are no nicks 
or burrs on the end. 

• Tighten all fittings fingertight. After starting operation, check for 
leaks and tighten more only if a fitting is leaking. If you use a wrench, 
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tighten by small increments (about 1/16th of a turn), just until the leak 
stops. Severe overtightening of the bolt can damage the port.

B.5 Connecting the Drain Tube

Connect the drain tube (P/N 055075) to the drain port on the Dionex VWD rear 
panel (see Figure B-6). Place the free end of the tube in a waste container below 
the level of the workbench on which the Dionex VWD is installed.

The drain tube must remain below the drain port. If any part of the
drain tube is above the drain port, the drip tray may overflow inside
the detector.

Figure B-6.  Dionex VWD Rear Panel

Drain Port
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B.6 Connecting the Digital I/O

Two digital I/O ports (A and B) on the Dionex VWD rear panel (see Figure B-6) 
provide four TTL inputs and four relay outputs for communication with external 
devices. The two ports are identical in function.

Table B-1 lists the functions assigned to the connector pins and the color of the 
cable wire connected to each pin.

Figure B-7.  6-Pin Mini-DIN Digital I/O Ports

Pin Signal Name Signal Level Wire Color Remark

1 Digital out relay 3 
(port A)
Digital out relay 4 
(port B)

Potential 
free

Pink (or 
Red)

If the relay is activated, the 
connection is between the 
Digital out relay and the 
Digital out relay common.

2 Digital in plus 3 
(port A)
Digital in plus 4 
(port B)

TTL Gray A voltage between 0 and +10V 
with respect to Digital in 
common can be applied to the 
input. A voltage of +4V is 
sufficient to switch the input. 

3 Digital in common Potential 
free

Green Ground for the Digital in plus 
signals.

5 Digital in plus 1 
(port A)
Digital in plus 2 
(port B)

TTL Yellow A voltage between 0 and +10V 
with respect to Digital in 
common can be applied to the 
input. A voltage of +4V is 
sufficient to switch the input. 

Table B-1. Digital I/O Ports A and B Pin and Cable Wire Assignments  

12

5 3

8 6

Digital in 
common

Digital out 
relay 1

12

5 3

8 6

Digital out
relay common

Digital in
plus 1

Digital in
plus 3

Digital out 
relay 3

Digital out
relay common

Digital in
plus 2

Digital in
plus 4

Digital out 
relay 2

Digital out 
relay 4

Digital in 
common

A B
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NOTE There is no connection between Digital out relay
common and Digital in common. They have neither a
conductive connection to protective ground nor to
internal signals in the detector.

1. Locate the 6-pin mini-DIN cable (P/N 6074.0001) provided in the 
Dionex VWD Ship Kit (P/N 064787). 

2. Plug the cable’s 6-pin connector into Digital I/O port A (or B).

3. For each relay output or TTL input to be used, connect the 
appropriate signal wire and ground wire to the corresponding 
connectors on the external device. Refer to the documentation 
provided with the external device for instructions.

4. When configuring the Dionex VWD in the Instrument Configuration 
program (Chromeleon 7) or Server Configuration program 
(Chromeleon 6.8) (see Section B.11.3), enable the corresponding 
relay output and/or TTL input on the Relays and/or Inputs tab page 
of the Properties dialog box.

B.7 Installing the Analog Outputs (Optional)

An optional DAC plug-in module (P/N 066349) (see Figure B-8) is available from 
Thermo Scientific. When the module is installed, two analog outputs with a 
resolution of 20 bits each are available on the Dionex VWD rear panel. The 
analog outputs supply a voltage signal proportional to the current measured by the 
detector cell. The outputs can be connected to an analog-to-digital (A/D) 

6 Digital out relay 1 
(port A)
Digital out relay 2 
(port B)

Potential 
free

Brown If the relay is activated, the 
connection is between the 
Digital out relay and the 
Digital out relay common.

8 Digital out relay 
common

Potential 
free

White Common relay contact.

The maximum switching voltage of the relays is 24V. The switching
current must not exceed 100 mA. The differential voltage between
Digital in plus and Digital in common must not exceed 10V.

Pin Signal Name Signal Level Wire Color Remark

Table B-1. Digital I/O Ports A and B Pin and Cable Wire Assignments (Continued) 
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converter such as an integrator or other recording device. Refer to Section B.7.2 
and the documentation for the device for connection instructions.

The analog output voltages are updated with a data rate of 10 Hz (for the single-
channel Dionex VWD) or 50 Hz (for the four-channel Dionex VWD).
 

B.7.1 Installing the DAC Plug-In Module

1. Turn off the detector and disconnect the power cord from its source.

2. Use appropriate grounding protection to avoid electrostatic discharge, 
which may result in damage to electronics components.

3. Remove the four screws indicated in Figure B-9 and remove the 
access panel on the detector’s rear panel. Save the screws.

 

Figure B-8.  DAC Plug-In Module

Figure B-9.  Removing the DAC Access Panel

Remove
Screws (4)



Dionex VWD Operator’s Manual

92 Doc. 065377-01 1/12

4. Slide the guide bar of the DAC plug-in module onto the green edge 
next to the USB port (see Figure B-10). 

 

5. Push the DAC plug-in module partially into the enclosure. Apply 
slight pressure between the two analog outputs to push the module 
further into the enclosure until it locks into position.

6. Secure the DAC plug-in module with the four screws removed in 
Step 3.

B.7.2 Connecting the Analog Outputs to the External Device

1. Locate the analog output cable (P/N 6074.0002) provided with the 
DAC plug-in module.

2. Plug the cable connector into the analog output on the Dionex VWD 
rear panel.

3. Connect the other end of the cable to the analog input on the external 
device (integrator, recorder, etc.).

NOTE Several settings are available for configuring the
analog output signal (output mode, full-scale range,
and mAU range). Refer to Section 2.4.4 for details. 

Figure B-10.  Installing the DAC Plug-In Module

USB Port

Guide Bar
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B.8 Connecting the Dionex VWD to the Chromeleon PC

B.8.1 Before You Begin

Before connecting the USB cable (see Section B.8.2) or the power cord 
(see Section B.9), verify that the following tasks have been completed:

• Chromeleon 7 or Chromeleon 6.8 is installed on the PC.

• The Chromeleon 7 or Chromeleon 6.8 license is installed.

NOTE Dionex strongly recommends installing Chromeleon
before connecting the Dionex VWD to the PC. When
you install the software first, the USB driver for the
detector is automatically loaded and the Windows
operating system can detect the Dionex VWD when
the power is turned on.

If installation is required, follow the instructions in the appropriate 
installation guide. The guides are provided on the Thermo Scientific 
Reference Library DVD (P/N 053891).

• For Chromeleon 7, refer to Chromeleon 7 Installation Guide.

• For Chromeleon 6.8, refer to Installing the Chromeleon 
Chromatography Management System with a Dionex Ion 
Chromatograph (Document No. 031883).

B.8.2 Connecting the USB Cable

Select one of the following methods to connect the detector to the PC on 
which the Chromeleon instrument controller or server is installed:

• Connect the detector directly to the USB port on the PC.

• Connect the detector to an internal USB port on another module in the 
system that is connected to the PC.

• Connect the detector to an external USB hub. 
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To connect the Dionex VWD directly to the PC:

1. Plug the “A” connector of the USB cable (P/N 063246) into the USB 
port on the PC (see Figure B-11).

2. Plug the “B” connector of the USB cable into the USB receptacle on 
the Dionex VWD rear panel.

Figure B-11.  Dionex VWD Connected Directly to the Chromeleon PC

USB Cable
(P/N 063246)

A

B

Plug the “B”
into the USB 

receptacle on the VWD.

USB cable’s 
connector 

Plug the “A”
into USB 

port on the PC.

USB cable’s 
connector the 

VWD

PC
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To connect the Dionex VWD to an internal hub on another module:

NOTE If you are installing a Dionex VWD with a Dionex
ICS-5000 Ion Chromatography System, refer to the
system installation instructions for information
about USB compatibility issues with Dionex ICS-
5000 systems.

1. Plug the “A” connector of the USB cable (P/N 063246) into the USB 
port on the module with the internal hub.

2. Plug the “B” connector of the USB cable into the USB receptacle on 
the Dionex VWD rear panel (see Figure B-12).

The USB standard limits the USB cable length to 5 meters
(5.5 yards). Each USB device can be separated from the PC by
no more than five hubs. Thus, if five hubs are installed, each
USB device can be located no more than 30 meters (32 yards)
from the PC.

Figure B-12.  Example USB Connection: 
Dionex VWD Connected to Another Module in the System

B

USB Cables

B A

A
PC

VWD

Module with 
Internal 

USB Hub
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To connect the Dionex VWD to an external USB hub:

The Dionex VWD Ship Kit includes one USB cable (P/N 063246). You 
must order another USB cable for this configuration.

1. Plug the “A” connector of a USB cable into a port on the external 
USB hub (see Figure B-13).

2. Plug the “B” connector of the cable into the USB receptacle on the 
Dionex VWD rear panel.

3. Plug the “A” connector of a USB cable into a USB port on the PC. 

4. Plug the “B” connector of the cable into a receptacle on the USB hub.

The USB standard limits the USB cable length to 5 meters
(5.5 yards). Each USB device can be separated from the PC by
no more than five hubs. Thus, if five hubs are installed, each
USB device can be located no more than 30 meters (32 yards)
from the PC.

Carefully secure all USB cables, the USB hub, and the hub
power cable so that they cannot be accidentally disconnected.

Figure B-13.  Example Connections: 
Multiple Modules Connected via an External USB Hub
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B.9 Connecting the Power Cord

1. Verify that the main power switch on the rear panel of the Dionex VWD is 
turned off. (The main power switch may be turned on accidentally when the 
detector is unpacked.)

2. Connect a modular power cord (IEC 320 C13) from the Dionex VWD main 
power receptacle (see Figure B-6) to a grounded, single-phase power source. 
The power supply is auto-sensing: No adjustment is needed to select the line 
voltage.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the Dionex VWD or connect it to the AC
power source without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the Dionex VWD and is easily
accessible.

Operation at AC input levels outside of the specified operating voltage
range may damage the Dionex VWD.

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne
le branchez pas au secteur C.A. sans utiliser de branchement mis à la
terre.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
werden.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.
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B.10 Turning On the Dionex VWD Power

1. Turn on the PC power, if it is not already on.

2. If this is a local PC, log onto Windows Vista or Windows XP as an 
administrator. 

If this is a network PC, log on as a user with local PC administrator privileges.

3. To start the Chromeleon 7 Instrument Configuration program:

Right-click the Chromeleon tray icon  (which is crossed out in red) and 
click Start Chromeleon Instrument Controller. The icon changes to gold 

 to indicate that the Instrument Controller Service is starting. When the 

Instrument Controller Service is running (idle), the icon changes to gray . 

If the Chromeleon tray icon is not on the taskbar, click Start > All Programs 
> Chromeleon 7 > Services Manager to open the Services Manager and 
click Start Instrument Controller. 

4. To start the Chromeleon 6.8 Server Monitor program:

Right-click the Chromeleon Server Monitor tray icon (which is crossed 
out in red) on the Windows taskbar and click Start Server. The icon changes 

to gold to indicate that the Chromeleon Server is starting. When the 

Chromeleon Server is running (idle), the icon changes to gray .

If the Server Monitor icon is not on the taskbar, click Start > All Programs > 
Chromeleon >Server Monitor to open the Server Monitor and click Start.

5. Turn on the main power switch on the rear panel of the Dionex VWD.

NOTE Always leave the main power switch on unless instructed
to turn it off. Use the power button on the front of the
detector for on/off control. To turn off the detector, press
and hold the power button for 2 seconds.

Before turning on the Dionex VWD power, verify that Chromeleon 7 or
Chromeleon 6.8 was installed on the PC and the license code was
entered. If the chromatography software is not installed first, Windows
will be unable to identify the detector.
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6. Microsoft Windows will automatically detect the new detector and launch the 
Found New Hardware Wizard. Use the wizard to install the detector as 
described below.

a. If asked whether Windows can connect to Windows Update to search for 
software, select No, not this time.

b. Accept the default option (Install the software automatically) and click 
Next >.

c. When the hardware wizard reports that the software for the detector has 
been installed, click Finish. 

NOTE If Windows fails to detect the Dionex VWD, refer to
Section 4.9 for troubleshooting help.

B.11 Setting Up the Chromatography Software

This section provides brief instructions for setting up Chromeleon 7 or 
Chromeleon 6.8 software. For details about any of these steps, refer to the 
Chromeleon Help.

B.11.1 Chromeleon 7: Assigning the Dionex VWD to an 
Instrument

After the Windows Found New Hardware Wizard is finished (see 
Section B.10), follow the steps below to add the Dionex VWD to a 
Chromeleon 7 instrument.

1. Click Start on the taskbar and select All Programs > Chromeleon 7 
> Services Manager to open the Services Manager. Click Start 
Instrument Controller. 

2. Click Configure Instruments to start the Instrument Configuration 
program.

3. If necessary, click the plus sign beside the instrument controller name 
to display the items underneath.

4. Select the instrument to which the Dionex VWD will be assigned, or 
create a new instrument (select Edit > Add Instrument).
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5. Select Edit > Add Module or right-click and select the command on 
the context menu.

The Add module to instrument dialog box appears.

6. Under Manufacturers, select IC: ICS-5000 Systems or IC: 
Modules.

7. Under Modules, select VWD Variable Wavelength Detector (ICS) 
(see Figure B-14) and click OK.

8. The Properties dialog box for the Dionex VWD appears. Check that 
the default settings are correct for your system and select other 
settings, if needed (see Section B.11.3). Click OK to close the dialog 
box.

9. Save the configuration (select File > Save Installation).

Figure B-14.  Adding the Dionex VWD to an Instrument
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B.11.2 Chromeleon 6.8: Assigning the Dionex VWD to a 
Timebase

After the Windows Found New Hardware Wizard is finished (see 
Section B.10), follow the steps below to add the Dionex VWD to a 
Chromeleon 6.8 timebase.

1. Start the Server Configuration program by clicking Start on the 
taskbar and selecting All Programs > Chromeleon 6.8 > Server 
Configuration. 

2. If necessary, click the plus sign beside the server name to display the 
items underneath.

3. Select the timebase to which the Dionex VWD will be assigned, or 
create a new timebase (select Edit > Add Timebase).

4. Select Edit > Add Device or right-click and select the command on 
the context menu.

The Add device to timebase dialog box appears.

5. Under Manufacturers, select IC: ICS-5000 Systems or IC: 
Modules.
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6. Under Devices, select VWD Variable Wavelength Detector (ICS) 
(see Figure B-15) and click OK.

7. The Properties dialog box for the Dionex VWD appears. Check that 
the default settings are correct for your system and select other 
settings, if needed (see Section B.11.3). Click OK to close the dialog 
box.

8. Save the configuration (select File > Save Installation).

Figure B-15.  Adding the Dionex VWD to a Timebase
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B.11.3 Selecting Configuration Properties

When the Dionex VWD is added to an instrument or a timebase, default 
configuration properties are selected. You can verify that the default 
settings are correct for your system and select other settings, if needed.

1. To open the Properties dialog box if it is not already open, right-click 
the Dionex VWD in the instrument or timebase and click Properties. 

2. On each tab page in the Properties dialog box, select the preferred 
settings. (See the following sections for descriptions of the various 
tab pages.)

3. When you finish, click OK to close the dialog box. 

4. Select File > Save Installation and then close the Instrument 
Configuration program or Server Configuration program.

 For more information about how to configure the detector, refer to the 
Chromeleon 7 or Chromeleon 6.8 Help.

General Tab Page

The General tab page displays the module address of the detector and the 
name of the firmware file currently installed in the detector. If an update 
is ever required, click the Download button to download new firmware.
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Detector Tab Page

The Detector tab page (see Figure B-16) displays the type of Dionex 
VWD installed (1 Channel or 4 Channels) and the device name (UV) 
used to identify the detector in the configuration and in the Chromeleon 
client. Thermo Scientific recommends retaining the default device name 
because the name is linked to various controls in the Chromeleon client. If 
you change the name, the controls will no longer function.

Select the corresponding check box for each option currently installed in 
the detector: UV Lamp, VIS Lamp, and DAC Board.

Signals Tab Page

The Signals tab page lists the signals that the detector can record. The 
signal type and name of each signal is displayed. To allow raw data 
collection for a signal, select the Enabled check box next to its name. If 
the check box is cleared, the detector cannot collect raw data for the 
signal. 

Figure B-16.  Dionex VWD Configuration Properties: Detector Tab Page
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Relays Tab Page

The Relays tab page lists all available relays. Select a check box to enable 
the corresponding relay. If a check box is cleared, the relay will not be 
available in Chromeleon. To change a relay name, overwrite the existing 
name directly in the Name field.

Inputs Tab Page

The Inputs tab page lists all available remote inputs. Select a check box 
to enable the corresponding input. If a check box is cleared, the input will 
not be available in Chromeleon. To change an input name, overwrite the 
existing name directly in the Name field.

Figure B-17.  Dionex VWD Configuration Properties: Relays Tab Page
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C • Reordering Information

Part Number Item

066347 Deuterium lamp

066348 Tungsten lamp

066346 Standard flow cell, 11 L volume, 10 mm path length, PEEK

6074.0300 Semi-micro flow cell, 2.5 L volume, 7 mm path length, 
PEEK

066349 DAC plug-in module (analog output)

6074.0002 DAC cable (analog output)

6074.0001 6-pin mini-DIN cable, 5 m (16 ft)

063246 USB cable, 0.9 m (3 ft)

055075 Drain tube

052308 Tubing, 0.51-mm (0.020-in) ID PEEK (6 m [20 ft])

052306 Tubing, 0.25-mm (0.010-in) ID PEEK (1.5 m [5 ft])

052311 Tubing, 0.125-mm (0.005-in) ID PEEK (6 m [20 ft])

043276 Ferrule fitting, 10-32 double-cone

043275 Fitting bolt, 10-32 (for 10-32 double-cone ferrule fitting)

954776 Fuse, IEC 60127-2 time lag rated at 2 A, 250 VAC
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D • UV Absorbances

D.1 UV Cutoff Wavelengths of Common Mobile Phases

The mobile phase composition affects its UV cutoff (the minimum effective 
wavelength for the measurement). In general, mobile phases are solvents such as 
water, acetonitrile, or methanol. They may also contain salts, such as sodium 
hydroxide. 

The UV cutoff wavelengths of these solvents may differ from the predicted values 
listed in Table D-1. Among other factors, the degassing quality and purity grade of 
the solvent affect the UV cutoff. Therefore, the values listed in Table D-1 are 
approximate values only. The cutoffs listed in the table apply to spectro-quality 
grade solvents.

Solvent UV Cutoff 
(nm)

Refractive 
Index

Selectivity 
Group

Acetic acid 208 1.370 IV

Acetone 330 1.356 VIa

Acetonitrile 190 1.341 VIb

Dioxane 215 1.420 VIa

Ethanol 210 1.359 II

Ethyl acetate 256 1.370 VIa

Hexane sulfonic acid (0.005 M) 230   

Isopropanol 205 1.384 II

Methanol 205 1.326 II

Methylene chloride 233 1.421 V

n-Hexane 190 1.372 VII

Octane sulfonic acid 230   

Sodium carbonate (0.01 M) 210   

Sodium hydroxide (0.1 M) 217   

Tetrabutylammonium hydroxide 
(0.005 M)

215   

Table D-1. Properties of Common Mobile Phases
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D.2 UV Absorbance Wavelengths of Chromophores

Table D-2 lists the wavelengths for the absorption maxima of various 
chromophores.
 

Tetrahydrofuran 212 1.405 III

Tetrapropylammonium hydroxide 195   

Toluene 285 1.494 VII

Triethylamine  1.398 I

Water 1.333 VIII

Functional Group Chromophore Wavelength (nm)

Aldehyde –CHO 280–300

Amine –NH2 195

Anthracene 252

375

Azido >C=N– 190

Azo –N=N– 285–400

Benzene 202

255

Bromide –Br 208

Carboxyl –COOH 200–210

Diphenyl 246

Disulfide –S–S– 194

255

Esters –COOR 205

Ether –O– 185

Iodide –I 260

Isoquinoline 218

Table D-2. UV Absorbance Wavelengths of Various Chromophores

Solvent UV Cutoff 
(nm)

Refractive 
Index

Selectivity 
Group

Table D-1. Properties of Common Mobile Phases (Continued)
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266

317

Ketone >C=O 270–280

Naphthalene 220

275

312

Nitrate –ONO2 270 (shoulder)

Nitroso –N=O 302

Olefins C=C– 185

Oxalic acid HOOC–COOH 250

Pyridine 195

251

Quinoline 227

270

314

Thioether –S– 194

215

Thioketone >C=S 205

Thiol –SH 195

Functional Group Chromophore Wavelength (nm)

Table D-2. UV Absorbance Wavelengths of Various Chromophores (Continued)
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Index

Symbols
% Offset (analog out), 18

A
Absorbance calculation, 3
Absorbance wavelengths, 5, 109
Air bubbles in cell

Preventing, 57
Alarm conditions, 44 – 54
Alarm LED

Clearing the alarm, 55
LED is lighted, 10

Analog output, 17
Cable, 92
DAC plug-in module installation, 90
Mode, 18
Offset level, 18
Range, 18
Resolution, 18
Signal type, 18

Analog-to-digital converter, 17, 90
Asymmetrical peaks, 34
Audit Trail, 10

Error messages, 41 – 42, 44 – 54
Icons, 41

Automated control, 22, 33
Average

Definition, 37
Guidelines for selecting, 37

B
Backpressure line, 57
Baseline drift

Troubleshooting, 58 – 59
Baseline equilibration, 29

Baseline noise
Troubleshooting, 56 – 58

C
Cables

Analog output, 92
Digital I/O, 17, 89
USB, 17, 93 – 95, 107

Calculating absorbance, 3
Calibration (wavelength), 64
Cells

See Flow cells
See Semi-micro flow cell
See Standard flow cell

Check (self-test), 25
Chromeleon 6.8, 21

Audit Trail, 10, 41
Audit Trail error messages, 41
Automated control, 33
Commands dialog box, 32
Configuration, 103 – 105
Connecting to, 27
Control panel, 28
Direct control, 30
Installation, 93
Panel tabset, 21, 28
Program, 33
Properties dialog box, 31
Quantification method, 33
Running a program, 33
Sequence, 33
Setup, 99, 101 – 103
Smart Startup feature, 30
Starting the client, 27
System Wellness, 23
UV Options page, 34
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Chromeleon 7, 21
Audit Trail, 10, 41
Audit Trail error messages, 41
Automated control, 33
Channels page, 34
Command window, 31
Configuration, 103 – 105
Connecting to, 26
Direct control, 30
ePanel, 26
ePanel Set, 21
Installation, 93
Instrument method, 22, 33
Processing method, 33
Properties dialog box, 31
Running an instrument method, 33
Sequence, 33
Setup, 99 – 100, 103
Smart Startup feature, 30
Starting the client, 26
System Wellness, 23

Chromeleon Server (Chromeleon 6.8)
Starting, 27

Chromophores
Absorbance wavelengths, 110

Command window (Chromeleon 7)
Opening, 31
Selecting a display filter, 32

Commands dialog box (Chromeleon 6.8)
Opening, 32
Selecting a display filter, 32

Components elute slowly, 56
Configuring the VWD, 103 – 105
Connected LED, 10
Connections

Analog output, 17
Digital I/O, 89 – 90
See also Installation

Control
Automated, 33
Direct, 30

D
DAC plug-in module, 17

Cable connections, 92
Configuration, 18
Enabling, 104
Installation, 90 – 92

Daily maintenance, 38
Data collection rate

Guidelines for selecting, 34
Relationship to step, 36

Data files occupy too much disk space, 35
Data points, 36

Collected per second, 34
Minimum number per peak, 34

Detector
Position in optical system, 15

Deuterium - UV LED, 10
Deuterium lamp

Lamp does not light, 56
Output waning, 57, 59
Position in optical system, 14
Replacing, 65
Wavelengths detected, 13

Digital I/O ports, 17
Connecting, 89

Dimensions, 75
Direct control, 22, 30
Disk space, 35
Drain tube, 19

Connecting, 88
Drip tray, 11
Dummy cell, 12

Removing, 84

E
Electrical specifications, 75
Eluents

See Mobile phases
Entrance slit

Position in optical system, 15
ePanel Set (Chromeleon 7), 21
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Equilibration (lamps), 29
Equilibration (system), 29, 56, 59

Creating a method or program, 30
Using the Smart Startup feature, 30

Error messages, 42, 44 – 54
Audit Trail, 41

Exchange
Deuterium lamp, 65
Flow cell, 72
Tungsten lamp, 69

F
Facility requirements, 81
Ferrule fittings, 63, 107
Filter paddle

Position in optical system, 14
Firmware, 23, 41

Updating, 103
Fittings

Replacing, 63
Requirements, 63

Flow cells
Air bubble prevention, 57
Backpressure line, 57
Cleaning, 71
Contaminants, 57
Description, 12
Heat exchanger, 12
Identification chip, 12
Installation, 84 – 85
Position in optical system, 15
Replacing, 72 – 73
See also Semi-micro flow cell
See also Standard flow cell

Four-channel VWD, 1
Data collection rate, 34

Front cover, 10
Front description, 9

Front cover, 10
LEDs, 10
Power button, 9
Status bar, 10

Full-scale analog output
Response range, 18

Fuses, 17
Replacing, 74
Specifications, 75

G
General tab page, 103
Goggles, UV, 72
Grating, 13

Position in optical system, 15

H
Heat exchanger, 12

Volume, 12
Holmium oxide filter, 77

Position in optical system, 14
Wavelength accuracy verification, 64

Hub, USB, 93
Humidity limits, 75

I
ICS-5000 systems, 1

USB compatibility issues, 95
Inputs

Enabling, 105
Installation

Analog outputs, 90
Chromeleon 6.8, 93
Chromeleon 6.8 setup, 99, 101 – 103
Chromeleon 7, 93
Chromeleon 7 setup, 99 – 100, 103
DAC plug-in module, 90 – 92
Detector placement in system, 82
Digital I/O connections, 89 – 90
Drain tube, 88
Facility requirements, 81
Flow cells, 84 – 85
Power cord, 97
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Unpacking instructions, 82
USB cable, 93 – 95
VWD with ICS-5000 system, 95

Instrument (Chromeleon 7)
Assigning the VWD to an instrument, 99
VWD not connected, 55

Instrument Controller Service (Chromeleon 7)
Starting, 26

Instrument method (Chromeleon 7), 22, 33
Instrument Method Wizard (Chromeleon 7)

Channels page, 34
Integrator, 18
Interior components, 11

L
Lambert-Beer's Law, 3
Lamps

Descriptions, 13
Deuterium (UV), 13
Deuterium lamp replacement, 65
Equilibration time, 29
Identification chip, 13
Monitoring the hours used, 39
Monitoring the intensity, 39
Tungsten (visible), 13
Tungsten lamp replacement, 69
Turning on, 29
Turning on automatically, 29

Leak drain, 11
Leak sensor, 11, 49
Leaks

Troubleshooting, 49
LEDs on front of detector, 10

Clearing the Alarm LED, 55
Flashing, 25

Linearity, 33
Locks (shipping), 82
Low lamp intensity, 49

M
Main power receptacle, 16
Main power switch, 16
Maintenance, 38

Daily, 38
Deuterium lamp replacement, 65
Fuse replacement, 74
Periodic, 39
Routine, 38
Shutdown, 37
Tungsten lamp replacement, 69

Mirrors
Position in optical system, 14 – 15

Mobile phases, 5, 19, 109
Degassing, 57
Delivery system, 20
Preparation, 19, 56, 58 – 59
Properties of, 109
UV cutoff wavelengths, 5, 109

Moduleware, 41
Updating, 103

Moving the detector, 38

O
Offset percentage (analog out), 18
Operating guidelines, 19

Mobile phase delivery system, 20
Mobile phase guidelines, 19
UV cutoff wavelengths, 5, 109
Wavelength selection, 19
Wavelengths of chromophores, 110

Operating parameters
Optimization, 33 – 37

Operating temperature, 75
Operation

Automated, 33
Direct control, 30
Power-up, 25
Principles of, 3

Optical system, 13 – 14
Overview of detector, 1
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P
Panel tabset (Chromeleon 6.8), 21
Peak broadening, 59, 73, 87
Peak height, 34
Peak resolution, 33
Peak width, 34 – 35
Peaks

Asymmetrical, 34
Co-eluting, 34
Identification, 33

PEEK tubing, 63
Performance optimization, 33 – 37
Periodic maintenance, 39
PGM file (Chromeleon 6.8), 23
Post-column reagents

Degassing, 57
Power

Turning on, 25
Power button (front of detector), 9
Power cord, 17, 97
Power LED, 10
Power receptacle, 16
Power requirements, 75
Power switch (rear panel), 16
Power-up, 25
Predictive Performance, 23
Principles of operation, 3
Problems

See Troubleshooting
Processing method (Chromeleon 7), 33
Product warranty, voiding, 63
Program (Chromeleon 6.8), 33
Program Wizard (Chromeleon 6.8)

UV options, 34
Properties dialog box, 31, 100, 102 – 103

Detector tab page, 104
General tab page, 103
Inputs tab page, 90, 105
Relays tab page, 90, 105

Pumping system, 20

Q
Quantification method (Chromeleon 6.8), 33

R
Range

Analog output, 18
Rear panel, 16

Clearance required, 58
Illustration, 16
Power switch, 16

Rear panel connections
Analog output, 17
Digital I/O, 89
Power cord, 17
USB cable, 17

Recorder
Analog output setting, 18

Reference beam, 3
Reference detector, 13

Position in optical system, 15
Reference mirror

Position in optical system, 15
Refractive index, 109
Regulatory information, 5
Relay outputs, 17
Relays

Enabling, 105
Reordering information, 107, 109
Replacing

Deuterium lamp, 65
Fittings, 63
Flow cell, 72
Fuses, 74
Tubing, 63
Tungsten lamp, 69

Reproducibility is poor, 60
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S
Safety labels, 7
Safety messages, 5
Sample wavelength

Guidelines for selecting, 37
Screws (shipping), 82
Selectivity group, 109
Self-test, 25
Semi-micro flow cell, 12

Heat exchanger, 12
Installation, 73
Specifications, 78

Sensitivity, 33
Sequence, 33
Server Configuration program (Chromeleon 
6.8)

Starting, 27
Server Monitor (Chromeleon 6.8), 27
Service

Deuterium lamp, 65
Flow cell, 72
Fuses, 74
Tungsten lamp, 69

Shipping locks, 82
Shipping the detector, 38
Short-term noise, 35
Shutdown procedures, 37

Long-term, 38
Short-term, 37
Smart Shutdown, 37

Signals
Analog output, 18
Digital I/O, 89
Enabling, 104
Equilibrating the baseline, 29
Signal-to-noise ratio, 34

Signal-to-noise ratio, 34
Single-channel VWD, 1

Data collection rate, 34
Smart Shutdown, 37
Solvent delivery system, 20
Solvents

See Mobile phases

Spare parts, 107, 109
Standard flow cell, 12

Heat exchanger, 12
Installation, 73
Specifications, 78

Standby procedures, 37
Startup, 25
Status bar

LEDs described, 10
Step

Definition, 36
Guidelines for selecting, 36
Selection by software, 36

System equilibration, 29, 56, 59
Using the Smart Startup feature, 30

System Wellness, 23

T
Time constant

Guidelines for selecting, 34
Recommended settings, 35

Timebase (Chromeleon 6.8)
Assigning the VWD to a timebase, 101
VWD not connected, 55

Troubleshooting, 41
ALARM LED is lighted, 55
Baseline drift, 58 – 59
Baseline noise, 56 – 59
Elution time is slow, 56
Lamp does not light, 56
Leaks, 49
Low lamp intensity, 49
Peak broadening, 59
Poor reproducibility, 60
VWD does not respond, 55
Windows error message, 55, 61

TTL inputs, 17
Tubing

Replacing, 63
Tubing chase, 11, 18
Tungsten - VIS LED, 10
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Tungsten lamp
Lamp does not light, 56
Output waning, 57, 59
Position in optical system, 14
Replacing, 69
Wavelengths detected, 13

U
Unpacking instructions, 82
USB

Connection to hub, 93
Connector on rear panel, 17

USB cable, 17, 107
Installation, 93 – 95

USB compatibility issues
With ICS-5000 systems, 95

UV absorbance wavelengths, 110
UV commands

In Chromeleon 6.8, 32
In Chromeleon 7, 32

UV cutoff wavelengths, 5, 109
UV goggles, 72
UV lamp

See Deuterium lamp
UV operation guidelines, 20
UV radiation, 65
UV wavelength range, 13
UV-Vis data, 34
UV-Vis detector

Specifications, 76
UV-Vis spectroscopy

Definition, 3

V
Verification (wavelength), 64
Vis (visible) lamp

See Tungsten lamp
VWD

Configuring in Chromeleon, 103 – 105
Control panel (Chromeleon 6.8), 21, 28

Dimensions, 75
Electrical specifications, 75
ePanel (Chromeleon 7), 21, 26
ePanel Set (Chromeleon 7), 21
Fuse requirements, 75
Operating humidity, 75
Operating temperature, 75
Overview, 1 – 2
Panel tabset (Chromeleon 6.8), 21
Power requirements, 75
Principles of operation, 3
Shipping instructions, 38
Specifications, 75
Versions, 1
Weight, 75

W
Warranty

Voiding, 63
Waste disposal, 38
Waste lines

Connecting the drain tube, 88
Installation, 87

Wavelength
Calibration, 64
Detection ranges, 13
Selection criteria, 19
UV cutoffs of mobile phases, 5, 109
Verification, 64 – 65

Weight, 75
Wellness, 23
Windows error message, 55, 61

Z
Zero position (analog out), 18
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